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This guide describes how to configure and use the webMethods PeopleSoft Adapter Version 6.0.
It contains information for administrators and application developers who want to exchange data
with PeopleSoft systems.
To use this guide effectively, you should be familiar with:
The PeopleSoft Internet Architecture (PIA) and how your organization uses it
The terminology and basic operations of your operating system
The setup and operation of the webMethods Integration Server.
How to perform basic tasks with Software AG Designer.

Document Conventions
Convention

Description

Bold

Identifies elements on a screen.

Narrowfont

Identifies service names and locations in the format folder.subfolder.service, APIs,
Java classes, methods, properties.

Italic

Identifies:
Variables for which you must supply values specific to your own situation or
environment.
New terms the first time they occur in the text.
References to other documentation sources.

Monospace font

Identifies:
Text you must type in.
Messages displayed by the system.
Program code.

{}

Indicates a set of choices from which you must choose one. Type only the
information inside the curly braces. Do not type the { } symbols.

|

Separates two mutually exclusive choices in a syntax line. Type one of these
choices. Do not type the | symbol.

[]

Indicates one or more options. Type only the information inside the square
brackets. Do not type the [ ] symbols.

...

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).
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Online Information and Support
Product Documentation
You can find the product documentation on our documentation website at https://
documentation.softwareag.com.
In addition, you can also access the cloud product documentation via https://www.softwareag.cloud.
Navigate to the desired product and then, depending on your solution, go to “Developer Center”,
“User Center” or “Documentation”.

Product Training
You can find helpful product training material on our Learning Portal at https://
knowledge.softwareag.com.

Tech Community
You can collaborate with Software AG experts on our Tech Community website at https://
techcommunity.softwareag.com. From here you can, for example:
Browse through our vast knowledge base.
Ask questions and find answers in our discussion forums.
Get the latest Software AG news and announcements.
Explore our communities.
Go to our public GitHub and Docker repositories at https://github.com/softwareag and https://
hub.docker.com/u/softwareag and discover additional Software AG resources.

Product Support
Support for Software AG products is provided to licensed customers via our Empower Portal at
https://empower.softwareag.com. Many services on this portal require that you have an account.
If you do not yet have one, you can request it at https://empower.softwareag.com/register. Once
you have an account, you can, for example:
Download products, updates and fixes.
Search the Knowledge Center for technical information and tips.
Subscribe to early warnings and critical alerts.
Open and update support incidents.
Add product feature requests.
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Data Protection
Software AG products provide functionality with respect to processing of personal data according
to the EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps are
documented in the respective administration documentation.
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1 About the PeopleSoft Adapter

Overview of the Adapter
The webMethods PeopleSoft Adapter is an add-on to the webMethods Integration Server that
allows you to exchange data with PeopleSoft systems. The adapter provides seamless and real-time
communications to and from PeopleSoft systems without requiring changes to the existing security
infrastructure.
Using the PeopleSoft Adapter, Integration Server clients can configure and run services that
perform operations to retrieve data from, and insert and update data in, PeopleSoft systems. For
example, you can use the PeopleSoft Adapter to add or modify employee records based on data
from other resources such as Siebel or Oracle Applications.
The PeopleSoft Adapter provides solutions for both webMethods-to-PeopleSoft (inbound)
communications and PeopleSoft-to-webMethods (outbound) communications.
PeopleSoft Server version 8.x introduced PeopleSoft's Pure Internet Architecture (PIA). The
PeopleSoft PIA includes PeopleSoft component interfaces (CIs), which enable external applications
to access objects created using PeopleSoft's Application Designer.
For webMethods-to-PeopleSoft communications, the PeopleSoft Adapter uses the PeopleSoft CI
APIs to exchange data with PeopleSoft systems by invoking operations and methods on PeopleSoft
Components via PeopleTools.
For PeopleSoft-to-webMethods communications, the PeopleSoft Adapter offers some pre-defined
flow services to make it easier to use PeopleSoft's Application Messaging capabilities.
For detailed installation instructions, see “Installing and Uninstalling the PeopleSoft Adapter ” on
page 31. For a list of the PeopleSoft versions and platforms that the PeopleSoft Adapter supports,
see the webMethods Adapters System Requirements .

Architecture and Components
This diagram illustrates how the PeopleSoft Adapter interfaces with a PeopleSoft system using
the PeopleSoft component interface Java APIs. Following the diagram are descriptions of the
different architectural pieces involved in the integration process.
For a more detailed description of the run-time data flow for the different types of PeopleSoft
Adapter services, see “Adapter Services” on page 16.

10
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webMethods Integration Server . The PeopleSoft Adapter is installed and runs on the
Integration Server.
WmART Package. The WmART package provides a common framework for webMethods 6.0
and later adapters to use Integration Server functionality, making the Integration Server the
run-time environment for the PeopleSoft Adapter. The WmART package is installed with the
Integration Server.
PeopleSoft Adapter . The PeopleSoft Adapter is delivered as a single package called
WmPeopleSoftAdapter.
The PeopleSoft Adapter provides Integration Server Administrator user interfaces that enable
you to configure and manage adapter connections, and Software AG Designer user interfaces
that enable you to configure and manage adapter services.
Adapter Connection Templates. Adapter connections enable the PeopleSoft Adapter to connect
to PeopleSoft systems. You must configure an adapter connection before you can configure
adapter services.
The adapter provides a template for adapter connections in the Integration Server Administrator.
For a detailed description of adapter connections, see “Adapter Connections” on page 14.
Adapter Service Templates. Adapter services enable the PeopleSoft Adapter to implement
component interface methods to perform operations on PeopleSoft components. The PeopleSoft
Adapter provides adapter service templates that enable you to configure services to find, get,
insert, update, and delete component interface instances (or records).
For example, a Get service could enable you to retrieve data records that are then passed to
another resource such as a custom benefits application. Or you could use an Insert service
within a flow service that takes data from another resource (for example, a database), and then
insert that data into a PeopleSoft system.
The PeopleSoft Adapter's adapter service templates are available in Designer. For a detailed
description of adapter services, see “Adapter Services” on page 16.
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PeopleSoft Libraries. The PeopleSoft Adapter requires PeopleSoft-supplied files to be able to
interface with the PeopleSoft component interfaces.
For more information about the PeopleSoft libraries that the adapter requires, see “Setting Up
Your Adapter's Environment” on page 44.
PeopleSoft Components. In PeopleSoft, applications are built using PeopleSoft components,
which are graphical user interface pages, business logic, and data, that are grouped together
for specific business purposes.
Component Interfaces. Component interfaces (CIs) are PeopleTools objects that expose
PeopleSoft component business logic and data to external applications, enabling the external
applications to find, create, modify, or delete data (records) from the components synchronously,
in real-time. The PeopleSoft Adapter uses PeopleSoft's component interface Java APIs to
perform operations on PeopleSoft components. PeopleSoft applications provide predefined
CIs; you can also create custom CIs using PeopleSoft's Application Designer.
A component interface maps to one, and only one, PeopleSoft component. A component
interface is created in the PeopleSoft Application Designer. Record fields on the PeopleSoft
component are mapped to the keys and properties of the component interface. Methods are
used to find, create, modify or delete data.
A CI instance is a CI object that is populated with a single group of data (called a record
throughout this guide) that describes a unique business object. The PeopleSoft Adapter enables
you to perform operations on CI records.
Component interface keys, methods, properties, and collections are described as follows:
Keys. Keys are properties containing values that uniquely identify an instance (or record)
of a component interface. When you create a component interface, keys are automatically
created based on the underlying component's search record. However, you can add or
change certain keys if desired.
Methods. A method performs a specified task on a component interface at run time. There
are two types of component interface methods: standard methods and user-defined methods.
The PeopleSoft Adapter supports standard methods, which are automatically generated
when you create a component interface.They provide basic data processing functions such
as Create, Find, Get, Cancel, and Save. Data collection methods enable you to access an
item by key, index, or effective date.
The PeopleSoft Adapter does not support user-defined methods.
Properties and Collections. Properties provide access to component data and CI settings
and status. There are two types of properties: standard properties and user-defined
properties. Standard properties (such as InteractiveMode, GetHistoryItems, and
EditHistoryItems) are assigned automatically when a component interface is created.
User-defined properties map to record fields in PeopleSoft components. Both types of
standard properties are available to the PeopleSoft Adapter.
Note:
The properties that are available to the adapter are limited to the properties that are
available for the version of PeopleSoft with which you are using the adapter.
12
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A collection is a group of properties that corresponds to a scroll level, its fields, and its
subordinate scrolls in the underlying component.
For more information about PeopleSoft components and component interfaces, see the
PeopleBooks documentation.
This diagram shows a typical business integration where an adapter service is used to update the
PeopleSoft system with employee data. The employee data could be provided by several different
types of external Integration Server clients.

For more detailed descriptions of run-time data flow and processing, see the descriptions of the
different types of services in “Adapter Services” on page 16.

Package Management
The PeopleSoft Adapter is provided as a package called WmPeopleSoftAdapter. You manage the
adapter package the same way you manage any package on the Integration Server. There are
webMethods PeopleSoft Adapter Installation and User’s Guide 6.0
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several considerations regarding how you set up and manage your packages on the Integration
Server, such as those described in the following list.
Create user-defined packages for your connections and adapter services. See “ PeopleSoft
Adapter Package Management” on page 36 for details.
Understand how package dependencies work so you make the best decisions regarding how
you manage your connections and adapter services. See “Package Dependency Requirements
and Guidelines” on page 36 for details.
Control which development groups have access to which adapter services. See“Group Access
Control” on page 38 for details.
Understand how clustering, an advanced feature of the Integration Server, works to effectively
manage your adapter services. See “ PeopleSoft Adapter in a Clustered Environment” on
page 38 for details.
Enable and disable packages. See “Enabling Packages” on page 37 and “Disabling Packages” on
page 38 for details.

Adapter Connections
The PeopleSoft Adapter uses adapter connections to define how its adapter services connect to
PeopleSoft systems. Each PeopleSoft Adapter connection contains a set of connection parameters,
including the release of the PeopleTools version to which the adapter will connect, and the logon
parameters that the adapter requires to connect to the PeopleSoft system.
You configure PeopleSoft Adapter connections for use with adapter services. You must configure
an adapter connection before you can configure an adapter service.
You configure connections using the Integration Server Administrator. For instructions for
configuring and managing PeopleSoft Adapter connections, see “Adapter Connections” on page 43.
Important:You can have only one PeopleSoft Adapter connection enabled at a time. If you have
one connection enabled but you need to configure or use a different connection, you must set
up your adapter's environment again to work with the new connection. See “Setting Up Your
Adapter's Environment” on page 44 for details. To support using the PeopleSoft Adapter with
multiple PeopleSoft instances simultaneously, you must have a separate Integration Server and
PeopleSoft Adapter installed and configured for each instance of PeopleSoft.

Connection Pooling
The Integration Server includes a connection management service that dynamically manages
connections and connection pools based on configuration settings that you specify for the
connection. All adapter services use connection pooling.
A connection pool is a collection of connections with the same set of attributes. The Integration
Server maintains connection pools in memory. Connection pools improve performance by enabling
adapter services to reuse open connections instead of opening new connections.

14
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Run-Time Behavior of Connection Pools
When you enable a connection, the Integration Server initializes the connection pool, creating the
number of connection instances you specified in the connection's Minimum Pool Size field.
Whenever an adapter service needs a connection, the Integration Server provides a connection
from the pool. If no connections are available in the pool, and the maximum pool size has not been
reached, the server creates one or more new connections (according to the number specified in
Pool Increment Size) and adds them to the connection pool. If the pool is full (as specified in
Maximum Pool Size), the requesting service will wait for the Integration Server to obtain a
connection, up to the length of time specified in the Block Timeout field, until a connection
becomes available. Periodically, the Integration Server inspects the pool and removes inactive
connections that have exceeded the expiration period that you specified in the connection's Expire
Timeout field.
If the connection pool initialization fails, due to a network connection failure or some other type
of exception, you can enable the system to retry the initialization any number of times, at specified
intervals.

Changing the Connection Associated With an Adapter Service
at Design Time
Integration Server provides a built-in service that you can use at design time to change the
connection associated with an adapter service. This built-in service, named
setAdapterServiceNodeConnection, is provided in the WmART package's pub.art.service folder. Using
this service, you can change the specific connection associated with an adapter service at design
time so that you do not need to create and maintain multiple adapter services.
Note:
You can run this built-in service only at design time; do not use it within an Integration Server
flow or Java service. You must run this service directly from Designer by selecting and running
the service.
For details, see the webMethods Integration Server Built-In Services Reference for your release.

Changing the Connection Associated with an Adapter Service
at Run Time
The Integration Server enables you to dynamically select the connection a service uses to interact
with the adapter's resource. This feature enables one service to interact with multiple, similar
backend resources.
For example, a service can be defined to use a default connection that interacts with your company's
production database. However, at run time you can override the default connection and instead
use another connection to interact with the company's test database.
For more information about overriding a service's default connection at run time, see “Dynamically
Changing a Service's Connection at Run Time” on page 52.
webMethods PeopleSoft Adapter Installation and User’s Guide 6.0
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Built-In Services For Connections
The Integration Server provides built-in services that enable you to programmatically control
connections. You can use them to:
Enable and disable a connection
Return usage statistics and the current state (Enabled or Disabled) and error status for a
connection
Change the connection associated with an adapter service (for more information, see “Changing
the Connection Associated With an Adapter Service at Design Time” on page 15).
These services are located in the WmART package, in the pub.art.connection folder. For details,
see the webMethods Integration Server Built-In Services Reference for your release.

Adapter Services
Adapter services enable the PeopleSoft Adapter to perform operations on PeopleSoft systems
through the use of PeopleSoft component interfaces. You configure adapter services using adapter
service templates, which are provided with the PeopleSoft Adapter. Each template represents a
CI operation. For example, the Get service template enables you to configure an adapter service
that uses the CI Get method to retrieve user-specified data from a PeopleSoft system. Adapter
service templates contain all of the code that is necessary to perform an operation on a PeopleSoft
system, but without the PeopleSoft CI data specifications. You provide these specifications when
you configure an adapter service.
Configuring a new service from an adapter service template is straightforward. UsingDesigner,
you assign a default adapter connection to the service, select the adapter service template, and
supply the service's data specifications.
After you configure a service, you can incorporate it into a flow or Java service to interact with a
PeopleSoft component interface. For example, you can create a flow service that collects employee
information from another backend system and then call an Insert adapter service within the flow
service to insert the employee information into your PeopleSoft system.
You can configure adapter services for PeopleSoft-supplied component interfaces or for custom
component interfaces. Before configuring services for custom component interfaces, you must
build the APIs for those component interfaces using PeopleSoft's Application Designer. See “Setting
Up Your Adapter's Environment” on page 44 for details.
The PeopleSoft Adapter provides adapter service templates for the following adapter services:
Service Type

Description

Get

The Get service retrieves a record from “Get Services” on page 17
PeopleSoft matching the data
specifications (keys) you specify.

16
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Service Type

Description

See page...

Find

The Find service retrieves a set of
records that match the data
specifications (keys) you specify.

“Find Services” on page 19

Insert

The Insert service inserts data records “Insert Services” on page 20
into a PeopleSoft system.

Update

The Update service identifies and then “Update Services” on page 22
updates a record in PeopleSoft.

Delete Row

The Delete Row service identifies a
“Delete Row Services” on page 25
child-level record that matches
user-specified key criteria, then deletes
the record.

Using Adapter Services
The following table lists the tasks required to use adapter services:
Task

Use...

1

Configure an adapter connection. See “Adapter
Connections” on page 43 for details.

Integration Server Administrator

2

Select the appropriate adapter service template and Designer
configure the adapter service.
See “Adapter Services” on page 57 for more
information about configuring adapter services.

3

If you plan to use an Integration Server flow or Java Designer
service to invoke the adapter service, design the flow
or Java service to use this adapter service. For details,
see the webMethods Service Development Help for your
release.

4

Manage the adapter service. See “Package
Designer and Integration Server
Management” on page 35, “Adapter Services” on Administrator
page 57, and Logging and Exception Handling for
details.

Get Services
The Get service retrieves a record from PeopleSoft that matches the data specifications (keys) you
specify. The Get service returns an entire CI record (all levels of the record). That is, the Get service
retrieves a parent-level record plus any of that record's child-level records.
webMethods PeopleSoft Adapter Installation and User’s Guide 6.0
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Note:The PeopleSoft Adapter does not support scroll-level processing, which is the ability to
access particular scroll-level items based on scroll keys. To retrieve child-level records (level 1
or higher), you must specify keys for the record's parent-level record (level 0) in the service's
input.

Get Service Run-Time Processing
This diagram illustrates the run-time data processing for the PeopleSoft Adapter's Get service.

Step

Description

1

A flow or Java service, typically invoked by an Integration Server client, initiates the
Get service on the Integration Server.
You configure the Get service, and the wrapping flow or Java service, using Designer.

2

The Get service retrieves a connection from the service's associated connection pool.
You configure and enable the adapter connection using the Integration Server
Administrator. For more information about connection pooling, including the run-time
behavior of connection pools, see “Connection Pooling” on page 14.

3

The Get service uses the PeopleSoft component interface Java APIs along with PeopleSoft
libraries (which you installed in the Integration Server in “Setting Up Your Adapter's
Environment” on page 44) to connect to the PeopleSoft system and identify the record
to retrieve. The service's input signature includes CI key fields that the service uses to
identify the record to retrieve.
You define the Get service's input signature when you create the service. Fields that you
select on the Key Fields tab in the adapter service template become the service's input
signature.

4

The component interface returns the matching record, and any of that record's child-level
records, to the Integration Server pipeline in the form of an IData object. The IData object

18
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Step

Description
preserves the parent-child structure of the CI and consists of the properties that are
selected on the service's Output Fields tab.
Note:
If more than one parent-level record matches the keys specified in the service's input,
the adapter returns null and the PeopleSoft server issues an error message.

Find Services
The Find service retrieves a set of records from PeopleSoft that match the data specifications (keys)
you specify.
When specifying keys, you can specify a full name, a partial name, or you can leave the field empty.
If you leave the field empty, the service will retrieve all records. You can also use the wildcard
characters supported by PeopleSoft, which are the percent sign character (%) and the underscore
character ( _ ).
Using the percent sign (%) in a field will match a string of zero or more characters. For example:
A% matches any string starting with A, including just A.
Using the underscore character (_) in a field will match any single character. For example: _om
matches a string that begins with any character followed by _om, such as Tom or Home.
To use one of the PeopleSoft wildcard characters as a literal character in a key field (for example,
to include an underscore (_) in your string), precede the character with a backslash character (\).
For example: \_.
Note:
PeopleSoft allows a Find operation to return a maximum of 300 records. When the operation
finds more than 300 records, the adapter returns only the first 300 records, and generates a
warning message issued by the PeopleSoft server.

Find Service Run-Time Processing
This diagram illustrates the run-time data processing for the PeopleSoft Adapter's Find service.

webMethods PeopleSoft Adapter Installation and User’s Guide 6.0
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Step

Description

1

A flow or Java service, typically invoked by an Integration Server client, initiates the
Find service on the Integration Server.
You configure the Find service, and the wrapping flow or Java service, using Designer.

2

The Find service retrieves a connection from the service's associated connection pool.
You configure and enable the adapter connection using the Integration Server
Administrator. For more information about connection pooling, including the run-time
behavior of connection pools, see “Connection Pooling” on page 14.

3

The Find service uses the PeopleSoft component interface Java APIs along with PeopleSoft
libraries (which you installed in the Integration Server in “Setting Up Your Adapter's
Environment” on page 44) to connect to the PeopleSoft system, validate the service's
input key fields (collection), and identify the records to retrieve. The service's input
signature includes CI key fields that the service uses to identify the records to retrieve.
You define the Find service's input signature when you create the service. Fields that
you select on the Key Fields tab in the adapter service template become the service's
input signature.

4

The component interface returns a set of find keys for zero or more parent-level CI
records that match the criteria specified in the Find service's input signature. The service
returns the data to the Integration Server pipeline in the form of a document list (IData
object).
You define the Find service's output signature when you create the service. Fields that
you select on the Output Fields tab in the adapter service template become the service's
output signature.

Insert Services
The Insert service inserts data records into a PeopleSoft system.
20
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The following list contains guidelines for using Insert services:
For the Insert service to run successfully, at least one non-key field must be specified in the
service's input signature.
To insert child-level records successfully, all key fields for the record must be specified in the
input signature.
If the record already exists in the PeopleSoft database, the service throws error message.
The Insert service enables you to simultaneously insert multiple rows of records of level 1 and
up.

Insert Service Run-Time Processing
The following diagram illustrates the run-time data processing for the PeopleSoft Adapter's Insert
service.

Step

Description

1

A flow or Java service, typically invoked by an Integration Server client, initiates the
Insert service on the Integration Server.
You configure the Insert service, and the wrapping flow or Java service, using Designer.

2

The Insert service retrieves a connection from the service's associated connection pool.
You configure and enable the adapter connection using the Integration Server
Administrator. For more information about connection pooling, including the run-time
behavior of connection pools, see “Connection Pooling” on page 14.

3

The Insert service uses the PeopleSoft component interface Java APIs along with
PeopleSoft libraries (which you installed in the Integration Server in “Setting Up Your
Adapter's Environment” on page 44) to connect to the PeopleSoft system, initiate create
keys, and insert the record (including all associated child-level records) into the
PeopleSoft system, assigning values to the fields specified in the service's input signature.
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Step

Description
If the service is successful, it executes the standard PeopleSoft Save method. The Save
method commits any changes to the database.
If the PeopleSoft server throws exceptions while creating or saving records, the adapter
will throw those same exceptions. For information about how the adapter handles
PeopleSoft errors, see “Handling PeopleSoft Exceptions” on page 104.
The service's input signature includes key fields that the component interface requires
to be able to insert a record into PeopleSoft, and input fields that the contain additional
fields for the record.
You define the Insert service's input signature when you create the service. All fields
on the Key Fields tab in the adapter service template are included in the service's input
signature, and fields that you select on the Input Fields tab, become the service's input
signature.

4

The Insert service returns a status document indicating whether or not the service was
successful. You can optionally include this status message in the service's output
signature. This status is added to the pipeline of the Insert service.
You define the Insert service's output signature when you create the service. Select the
STATUS option on the Output Fields tab in the adapter service template to include the
STATUS message in the service's output signature.

Update Services
The Update service identifies a specific CI record and then updates all levels of that record in
PeopleSoft, as specified in the service. The Update service enables you to simultaneously update
multiple rows of child-level (level 1 and up) records.
The Update service supports effective date processing. See “Effective Date Processing” on page 24
for more information about how Update services process operations with the Effective Date
Processing option enabled.
Note:The PeopleSoft Adapter does not support scroll-level processing, which is the ability to
access particular scroll-level items based on scroll keys, and then update or delete those items
in PeopleSoft. To update a child-level record (level 1 or higher), you must specify keys for all
of the record's parent-level records in the service's input.

Update Service Run-Time Processing
The following diagram illustrates the run-time data processing for the PeopleSoft Adapter's Update
service.
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Step

Description

1

A flow or Java service, typically invoked by an Integration Server client, initiates the
Update service on the Integration Server.
You configure the Update service, and the wrapping flow or Java service, using Designer.

2

The Update service retrieves a connection from the service's associated connection pool.
You configure and enable the adapter connection using the Integration Server
Administrator. For more information about connection pooling, including the run-time
behavior of connection pools, see “Connection Pooling” on page 14.

3

The Update service uses the PeopleSoft component interface Java APIs along with
PeopleSoft libraries (which you installed in the Integration Server in “Setting Up Your
Adapter's Environment” on page 44) to connect to the PeopleSoft system and then
identify and update the specified record.
The service allows you to update records at scroll levels 1 and up. Depending on the
key values specified in the input signature, the child record is updated as follows:
If the record already exists in PeopleSoft, the adapter updates it with the new data.
If the record does not exist in PeopleSoft, the adapter adds that row, plus all of its
child-level rows.
If the service is successful, it executes the standard PeopleSoft Save method. The Save
method commits any changes to the PeopleSoft database.
If the PeopleSoft server throws exceptions while creating or saving records, the adapter
will throw those same exceptions. For more information about how the adapter handles
PeopleSoft errors, see “Handling PeopleSoft Exceptions” on page 104.
You define the Update service's input signature when you create the service. Fields that
you select on the Key Fields tab in the adapter service template become the service's
input signature.
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Step

Description

4

The Update service returns a status document (called STATUS) indicating whether or
not the service was successful. You can optionally include this status document in the
service's output signature. This status is added to the pipeline of the Update service.
You define the Insert service's output signature when you create the service. Select the
STATUS option on the Output Fields tab in the adapter service template to include the
STATUS message in the service's output signature.

Effective Date Processing
The Update services can access and update effective-dated child-level records according to the
date of the record.
A record is defined as effective-dated if the EFFDT property exists in the record. The EFFDT
property must be a key. A record does not have to have the EFFSEQ property for the operation
to access an effective-dated record. If the EFFSEQ property does not exist, then the operation uses
0 as the sequence number.
The PeopleSoft Adapter takes {EFFDT, Sequence Number} input values and passes them into
PeopleSoft API getEffectiveItem(String date, long seqNum) to access a record.
The sequence number is equal to the EFFSEQ value or to 0. If a record with the specified EFFDT
and sequence number already exists in the database, then the record will be updated. If a record
with specified EFFDT and sequence number does not exist in the database, then a new record will
be inserted into the database.
For example, if there are three records in the database containing the following dates:
Row #

EFFDT

Sequence Number
(EFFSEQ)

COMPRATE

0

06/28/2005

0

15

1

06/17/2005

1

22

2

06/17/2005

0

25

The input parameters are {6/25/2005, 0}. The copy of row 1 will be created and the properties will
be updated based on input values. The result of Update operation will be:
Row #

EFFDT

Sequence Number
(EFFSEQ)

COMPRATE

0

06/28/2005

0

15

1

06/25/2005

0

22

2

06/17/2005

1

22
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Row #

EFFDT

Sequence Number
(EFFSEQ)

COMPRATE

3

06/17/2005

0

25

Note:
If a child collection's key set consists of EFFDT along with other properties, only the EFFDT
value will be used as a key to access the record for updates.

Delete Row Services
The Delete Row service identifies a child-level record that matches user-specified key criteria, then
deletes the record.
The following list contains guidelines for using Delete Row services:
The Delete Row service does not support deleting parent-level records.
The Delete Row service enables you to delete multiple child-level rows based on the keys
specified in service's input signature.
To delete a child-level row, you must specify key values for all of its parent levels. For example,
to delete a level 3 record, you must specify key values for its level 1 and level 2 parent-level
records.
If the service's input signature only contains key values for a level 1 record, then the whole
level 1 record will be deleted, along with all of its children level records (levels 2 and up).
Note:The PeopleSoft Adapter does not support scroll-level processing, which is the ability
to access particular scroll-level items based on scroll keys, and then update or delete those
items in PeopleSoft. To delete a child-level record (level 1 or higher), you must specify keys
for all of the record's parent-level records in the service's input.

Delete Row Service Run-Time Processing
The following diagram illustrates the run-time data processing for the PeopleSoft Adapter's Delete
Row service.
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Step

Description

1

A flow or Java service, typically invoked by an Integration Server client, initiates the
Delete Row service on the Integration Server.
You configure the Delete Row service, and the wrapping flow or Java service, using
Designer.

2

The Delete Row service retrieves a connection from the service's associated connection
pool.
You configure and enable the adapter connection using the Integration Server
Administrator. For more information about connection pooling, including the run-time
behavior of connection pools, see “Connection Pooling” on page 14.

3

The Delete Row service uses the PeopleSoft component interface Java APIs along with
PeopleSoft libraries (which you installed in the Integration Server in “Setting Up Your
Adapter's Environment” on page 44) to connect to the PeopleSoft system and identify
the parent-level record containing the child-level row to delete.
The service's input signature includes CI lookup key fields that the service uses to identify
the parent-level record, and delete key fields that the service uses to identify and delete
the child-level record.
You define the Delete Row service's input signature when you create the service. Fields
that you select on the Lookup Key Fields tab in the adapter service template, and fields
you select on the Delete Key Fields tab, become the service's input signature.

4

The Delete Row service returns a status document indicating whether or not the service
was successful. You can optionally include this status message in the service's output
signature. This status is added to the pipeline of the Delete Row service.
You define the Delete Row service's output signature when you create the service. Select
the STATUS option on the Output Fields tab in the adapter service template to include
the STATUS message in the service's output signature.
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Step

Description
You define the Delete Row service's output signature when you create the service. Fields
that you select on the Output Fields tab in the adapter service template become the
service's output signature.

PeopleSoft-to-webMethods Communications
This section provides an overview of the adapter's PeopleSoft-to-webMethods (outbound)
communications.
Note:
For PeopleSoft-to-webMethods communications, the PeopleSoft Adapter supports only the
PeopleTools versions specified in the webMethods Adapters System Requirements .
For PeopleSoft-to-webMethods communications, the PeopleSoft Adapter takes advantage of
PeopleSoft's Application Messaging (Integration Gateway) capabilities to invoke a service or post
data on the Integration Server by publishing the appropriate message to the PeopleSoft Integration
Broker.
You configure the PeopleSoft Integration Broker's Integration Gateway and define a node to
communicate with the Integration Server. When you configure your connector and define the
node, you specify an HTTPTARGET connector to post data to the Integration Server.
You specify a message in the PeopleCode program to be executed on a component's savePreChange
or savePostChange event. PeopleSoft calls a savePreChange event before any database updates;
PeopleSoft calls a savePostChange event after any database updates. You write a PeopleCode
program so that it converts the modified record into an XML String. The XML string is sent to the
HTTPTARGET connector you configured earlier. The HTTPTARGET connector then posts the
XML string to the Integration Server.
A receive service on the specified Integration Server is invoked when data inside a PeopleSoft
system is modified, added, deleted, or when any other kind of event occurs that requires invoking
a service. The adapter provides a sample flow service that receives the XML data, parses the XML
file, interprets the information, and then calls the appropriate service to perform the specified
operation. If the PeopleSoft system expects a reply, then a reply XML document can be returned
to the PeopleCode program. The PeopleCode program then interprets the returned XML string.
For a description of how PeopleSoft-to-webMethods transactions are processed, see “PeopleSoftto-webMethods Run-Time Processing” on page 27.
For instructions for creating and using PeopleSoft-to-webMethods operations, see “PeopleSoft-towebMethods Communications” on page 79.
For more information about Application Messaging and the Integration Broker, see the PeopleBooks
documentation.

PeopleSoft-to-webMethods Run-Time Processing
The PeopleSoft Adapter processes PeopleSoft-to-webMethods transactions at run time as follows:
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Step

Description

1

When data inside the PeopleSoft system is added, deleted, or modified, or when any
other kind of event occurs that you want to have trigger PeopleSoft-to-webMethods
communications, an HTTPTARGET Connector on the PeopleSoft system posts an XML
document to the webMethods Integration Server.

2

A PeopleSoft Adapter receive service (such as receiveXML) receives the XML data, parses
the XML file, interprets the information, and calls the appropriate service to perform
the specified operation.

3

The result is returned as a message to the PeopleCode program.

4

The PeopleCode program that receives the XML string then interprets the returned XML
string.

Using Version Control Systems to Manage Adapter Elements
The adapter supports the Version Control System (VCS) Integration feature provided by Designer.
When you enable the feature in Integration Server, you can check adapter packages or elements
into and out of your version control system from Designer. For more information about the VCS
Integration feature, see the Administering the VCS Integration Feature.
Beginning with Integration Server 8.2 SP3, the adapter supports the local service development
feature in Designer. This feature extends the functionality of the VCS Integration feature to check
package elements and their supporting files into and out of a VCS directly from Designer. For
more information about local service development and how it compares to the VCS Integration
feature, see the webMethods Service Development Help.
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Infrastructure Data Collector Support for the PeopleSoft Adapter
Infrastructure Data Collector monitors the system and operational data associated with webMethods
run-time components such as Integration Servers, Broker Servers, Brokers, and adapters, and
reports the status of these components on Optimize for Infrastructure or other external tools. When
you start monitoring an Integration Server, Infrastructure Data Collector automatically starts
monitoring all ART-based adapters that are installed on the Integration Server.
For information about monitored key performance indicators (KPIs) collected for the monitored
adapter components, see the Administering webMethods Optimize and webMethods Optimize User’s
Guide for your release.

Viewing the Adapter's Update Level
You can view the list of updates that have been applied to the adapter. The list of updates appears
in the Updates field on the adapter's About page in the Integration Server Administrator.

Controlling Pagination
When using the adapter on Integration Server 8.0 and later, you can control the number of items
that are displayed on the adapter Connections screen and Notifications screen. By default, 10 items
are displayed per page. Click Next and Previous to move through the pages, or click a page
number to go directly to a page.
To change the number of items displayed per page, set the watt.art.page.size property and specify
a different number of items.
To set the number of items per page
1. From Integration Server Administrator, click Settings > Extended.
2. Click Edit Extended Settings. In the Extended Settings editor, add or update the
watt.art.page.size property to specify the preferred number of items to display per page. For
example, to display 50 items per page, specify:
watt.art.page.size=50

3. Click Save Changes. The property appears in the Extended Settings list.
4. For more information about working with extended configuration settings, see the webMethods
Integration Server Administrator’s Guide for your release.
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Overview
This chapter explains how to install, upgrade, and uninstall webMethods PeopleSoft Adapter 6.0.
The instructions use the Software AG Installer and the Software AG Uninstaller wizards. For
complete information about the wizards or other installation methods, or to install other
webMethods products, see the Installing webMethods Products On Premises for your release.

Requirements
For a list of the operating systems, PeopleSoft products, and webMethods products supported by
PeopleSoft Adapter 6.0, see the webMethods Adapters System Requirements .
PeopleSoft Adapter 6.0 has no hardware requirements beyond those of its host Integration Server.

Installing PeopleSoft Adapter 6.0
Note:
If you are installing the PeopleSoft Adapter in a clustered environment, you must install the
adapter on each Integration Server in the cluster, and each installation must be identical. For
more information, see the “ PeopleSoft Adapter in a Clustered Environment” on page 38.
To install PeopleSoft Adapter 6.0
1. Download Software AG Installer from the Empower Product Support Web site.
2. If you are installing the adapter on an existing Integration Server, shut down Integration Server.
3. Start the Installer wizard.
Choose the webMethods release that includes the Integration Server on which to install
the adapter. For example, if you want to install the adapter on Integration Server 7.1, choose
the 7.1 release.
If you are installing on an existing Integration Server, specify the webMethods installation
directory that contains the host Integration Server. If you are installing both the host
Integration Server and the adapter, specify the installation directory to use. The Installer
will install the adapter in the Integration Server_directory \packages directory.
In the product selection list, select Adapters > webMethods PeopleSoft Adapter 6.0.
You can also choose to install documentation.
4. Copy the psjoa.jar file from your PeopleSoft system to the Integration Server_directory
\packages\WmPeopleSoftAdapter\code\jars directory.
5. After installation is complete, start the host Integration Server.
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Uninstalling PeopleSoft Adapter 6.0
Uninstalling PeopleSoft Adapter 6.0
1. Shut down the host Integration Server. You do not need to shut down any other webMethods
products or applications that are running on your machine.
2. The Software AG Uninstaller will not delete any user-defined PeopleSoft Adapter 6.0
components such as connections and adapter services. Because these components will not
work without the adapter, delete them manually, either at the file system level or using Software
AG Designer. For instructions, see the webMethods Service Development Help for your release.
3. Start Software AG Uninstaller, selecting the webMethods installation directory that contains
the host Integration Server. In the product selection list, select Adapters > webMethods
PeopleSoft Adapter 6.0. You can also choose to uninstall documentation.
4. Restart the host Integration Server.
5. Uninstaller removes all PeopleSoft Adapter-related files that were installed. However,
Uninstaller does not delete files created after you installed the PeopleSoft Adapter (for example,
user-created or configuration files), nor does it delete the adapter directory structure. You can
go to the Integration Server_directory \packages directory and delete the WmPeopleSoftAdapter
directory.
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Overview
The following sections describe how to set up and manage your PeopleSoft Adapter packages, set
up Access Control Lists (ACL), and use the adapter in a clustered environment.

PeopleSoft Adapter Package Management
The PeopleSoft Adapter is provided as a package called WmPeopleSoftAdapter. You manage the
WmPeopleSoftAdapter package as you would manage any package on the Integration Server.
When you configure connections and adapter services, define them in user-defined packages
rather than in the WmPeopleSoftAdapter package. Doing so will allow you to manage the package
more easily.
As you create user-defined packages in which to store connections and adapter services, use the
package management functionality provided in Designer and set the user-defined packages to
have a dependency on the WmPeopleSoftAdapter package. That way, when the
WmPeopleSoftAdapter package loads or reloads, the user-defined packages load automatically.
See the following diagram:

Package management tasks include:
Setting package dependencies (see “Package Dependency Requirements and Guidelines” on
page 36)
“Enabling Packages” on page 37
“Disabling Packages” on page 38

Package Dependency Requirements and Guidelines
Following are dependency requirements and guidelines for user-defined packages. For instructions
for setting package dependencies, see the webMethods Service Development Help for your release.
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A user-defined package must have a dependency on its associated adapter package,
WmPeopleSoftAdapter.
The WmPeopleSoftAdapter package has a dependency on the WmART package.
These first two dependencies ensure that at startup the Integration Server automatically loads
or reloads all packages in the proper order: the WmART package first, the adapter package
next, and the user-defined packages last. The WmART package is automatically installed when
you install the Integration Server. You should not need to manually reload the WmART
package.
If the connections and adapter services of an adapter are defined in different packages, then:
A package that contains the connections must depend on the adapter package.
Packages that contain adapter services must depend on their associated connection package.
Keep connections for different adapters in separate packages so that you do not create
interdependencies between adapters. If a package contains connections for two different
adapters, and you reload one of the adapter packages, the connections for both adapters will
reload automatically.
The Integration Server will not allow you to enable a package if it has a dependency on another
package that is disabled. That is, before you can enable your package, you must enable all
packages on which your package depends. For information about enabling packages, see
“Enabling Packages” on page 37.
The Integration Server will allow you to disable a package even if another package that is
enabled has a dependency on it. Therefore, you must manually disable any user-defined
packages that have a dependency on the adapter package before you disable the adapter
package. For information about disabling packages, see “Disabling Packages” on page 38.
You can name connections and adapter services the same names provided that they are located
in different packages and folders.

Enabling and Disabling Packages
Important:
Before you manually enable a user-defined package, you must first enable its associated adapter
package (WmPeopleSoftAdapter). Similarly, if your adapter has multiple user-defined packages,
and you want to disable some of them, disable the adapter package first. Otherwise, errors will
be issued when you try to access the remaining enabled user-defined packages.

Enabling Packages
All packages are automatically enabled by default.
To enable a package
1. Open the Integration Server Administrator if it is not already open.
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2. In the Packages menu of the navigation area, click Management.
3. Click No in the Enabled column. The server displays a

and Yes in the Enabled column.

Note:
Enabling an adapter package will not cause its associated user-defined packages to be
reloaded.

Disabling Packages
When you want to temporarily prohibit access to the elements in a package, disable the package.
When you disable a package, the server unloads all of its elements from memory. Disabling a
package prevents the Integration Server from loading that package at startup.
A disabled adapter will:
Remain disabled until you explicitly enable it using the Integration Server Administrator.
Not be listed in Designer.
To disable a package
1. Open the Integration Server Administrator if it is not already open.
2. In the Packages menu of the navigation area, click Management.
3. Click Yes in the Enabled column for the package that you want to disable. The server issues
a prompt to verify that you want to disable the package. Click OK to disable the package.
When the package is disabled, the server displays No in the Enabled column.

Group Access Control
To control which development group has access to which adapter services, use access control lists
(ACLs). You can use ACLs to prevent one development group from inadvertently updating the
work of another group, or to allow or deny access to services that are restricted to one group but
not to others.
For general information about assigning and managing ACLs, see the webMethods Service
Development Help for your release.

PeopleSoft Adapter in a Clustered Environment
What is webMethods Integration Server Clustering?
Clustering is an advanced feature of the webMethods product suite that substantially extends the
reliability, availability, and scalability of webMethods Integration Server. Clustering accomplishes
this by providing the infrastructure and tools to deploy multiple Integration Servers as if they
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were a single virtual server and to deliver applications that leverage that architecture. Because
this activity is transparent to the client, clustering makes multiple servers look and behave as one.
For details on webMethods Integration Server clustering, see the webMethods Integration Server
Clustering Guide for your release.
Integration Server 8.2 SP2 and higher supports the caching and clustering functionality provided
by Terracotta. Caching and clustering are configured at the Integration Server level and PeopleSoft
Adapter uses the caching mechanism that is enabled on Integration Server.
With clustering, you get the following benefits:
Load balancing. This feature, provided automatically when you set up a clustered environment,
allows you to spread the workload over several servers, thus improving performance and
scalability.
Failover support. Clustering enables you to avoid a single point of failure. If a server cannot
handle a request, or becomes unavailable, the request is automatically redirected to another
server in the cluster.
Note:webMethods Integration Server clustering redirects HTTP and HTTPS requests, but
does not redirect FTP or SMTP requests.
Scalability. You can increase your capacity even further by adding new machines running
webMethods Integration Server to the cluster.

Configuring the PeopleSoft Adapter For Clustering
When you configure the PeopleSoft Adapter, you must:
Ensure that each Integration Server in the cluster contains an identical set of packages. See
“Replicating Packages to webMethods Integration Servers” on page 39.
Disable the redirection capability for certain predefined administrative services. See “Disabling
the Redirection of Administrative Services” on page 39.

Replicating Packages to webMethods Integration Servers
Each Integration Server in the cluster should contain an identical set of packages that you define
using the PeopleSoft Adapter. That is, you should replicate the PeopleSoft Adapter services and
the connections they use.
To ensure consistency, you should create all packages on one server, and replicate them to the
other servers. If you allow different servers to contain different services, you might not derive the
full benefits of clustering. For example, if a client requests a service that resides in only one server,
and that server is unavailable, the request cannot be successfully redirected to another server.
For information about replicating packages, see the webMethods Integration Server Administrator’s
Guide for your release. See also “Requirements for Each Integration Server in a Cluster” on page 40.

Disabling the Redirection of Administrative Services
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As previously mentioned, a server that cannot handle a client's service request can automatically
redirect the request to another server in the cluster. However, the PeopleSoft Adapter uses certain
predefined administrative services that you should not allow to be redirected. These services are
used internally when you configure the adapter. If you allow these services to be redirected, your
configuration specifications might be saved on multiple servers, which is an undesirable result.
For example, if you configure two PeopleSoft Adapter services, one might be stored on one server,
while the other one might be stored on another server. Remember that all adapter services must
reside on all Integration Servers in the cluster.
To disable the redirection of administrative services
1. Shut down the Integration Server Administrator. For the procedure to do this, see the
webMethods Integration Server Administrator’s Guide for your release.
2. Edit the following file:
Integration Server_directory \config\redir.cnf
3. Add the following line to the file:
<value name="wm.art">false</value>

4. Save the file and restart the Integration Server.

Clustering Considerations and Requirements
Note:
The following sections assume that you have already configured the webMethods Integration
Server cluster. For details about webMethods clustering, see the webMethods Integration Server
Clustering Guide for your release.
The following considerations and requirements apply to the PeopleSoft Adapter in a clustered
environment.

Requirements for Each Integration Server in a Cluster
The following table describes the requirements for each Integration Server in a cluster:
All Integration Servers For Example ...
in a given cluster must
have identical...
Integration Server
versions

One Integration Server in the cluster cannot be version 6.5 and another
Integration Server in the cluster be version 8.0.

Adapter packages

All adapter packages on one Integration Server should be replicated to
all other Integration Servers in the cluster, as described in “Replicating
Packages to webMethods Integration Servers” on page 39.
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All Integration Servers For Example ...
in a given cluster must
have identical...
Adapter connections

If you configure a connection to the database, this connection must appear
on all servers in the cluster so that any Integration Server in the cluster
can handle a given request identically.
If you plan to use connection pools in a clustered environment, see
“Considerations When Configuring Connections with Connection Pooling
Enabled” on page 41.

Adapter services

Each adapter service must appear on all servers in the cluster so that any
Integration Server in the cluster can handle the request identically.
If you allow different Integration Servers to contain different services,
you might not derive the full benefits of clustering. For example, if a
client requests a service that resides on only one server, and that server
is unavailable, the request cannot be successfully redirected to another
server.

Considerations When Installing PeopleSoft Adapter Packages
For each Integration Server in the cluster, use the standard PeopleSoft Adapter installation
procedures for each machine, as described in “Installing and Uninstalling the PeopleSoft Adapter
” on page 31.

Considerations When Configuring Connections with Connection Pooling Enabled
When you configure a connection that uses connection pools in a clustered environment, be sure
that you do not exceed the total number of connections that can be opened simultaneously for
that database.
For example, if you have a cluster of two Integration Servers with a connection configured to a
database that supports a maximum of 100 connections opened simultaneously, the total number
of connections possible at one time must not exceed 100. This means that you cannot configure a
connection with an initial pool size of 100 and replicate the connection to both servers, because
there could be possibly a total of 200 connections opened simultaneously to this database.
In another example, consider a connection configured with an initial pool size of 10 and a maximum
pool size of 100. If you replicate this connection across a cluster with two Integration Servers, it is
possible for the connection pool size on both servers to exceed the maximum number of database
connections that can be open at one time.
For information about configuring connections for the PeopleSoft Adapter, see “Configuring
Adapter Connections” on page 47.
For more general information about connection pools, see the webMethods Integration Server
Administrator’s Guide for your release.

webMethods PeopleSoft Adapter Installation and User’s Guide 6.0

41

3 Package Management

42

webMethods PeopleSoft Adapter Installation and User’s Guide 6.0

4 Adapter Connections
■

Overview ........................................................................................................................

44

■

Before Configuring or Managing Adapter Connections ..................................................

44

■

Setting Up Your Adapter's Environment ..........................................................................

44

■

Configuring Adapter Connections ..................................................................................

47

■

Dynamically Changing a Service's Connection at Run Time .........................................

52

■

Viewing Adapter Connection Parameters .......................................................................

52

■

Editing Adapter Connections ..........................................................................................

53

■

Copying Adapter Connections ........................................................................................

54

■

Deleting Adapter Connections ........................................................................................

54

■

Enabling Adapter Connections .......................................................................................

55

■

Disabling Adapter Connections ......................................................................................

55

webMethods PeopleSoft Adapter Installation and User’s Guide 6.0

43

4 Adapter Connections

Overview
This chapter describes how to configure and manage PeopleSoft Adapter connections. For more
information about how adapter connections work, see “Adapter Connections” on page 14.
Important:
For the PeopleSoft Adapter, you can have only one connection enabled at a time. If you have
one connection enabled but you want to use a different connection, you must disable the current
connection and follow the instructions in “Setting Up Your Adapter's Environment” on page 44
to set up your adapter's environment to work with the new connection.

Before Configuring or Managing Adapter Connections
Important:
Make sure you have webMethods administrator privileges so that you can access the PeopleSoft
Adapter's administrative screens. For information about setting user privileges, see the
webMethods Integration Server Administrator’s Guide for your release.
To prepare to configure or manage adapter connections
1. Install the webMethods Integration Server and the PeopleSoft Adapter on the same machine.
See “Installing and Uninstalling the PeopleSoft Adapter ” on page 31 for details.
2. Set up your adapter's environment to work with the component interfaces on your PeopleSoft
system. See “Setting Up Your Adapter's Environment” on page 44.
3. Start your Integration Server and the Integration Server Administrator, if they are not already
running.
4. Using the Integration Server Administrator, make sure the WmPeopleSoftAdapter package is
enabled. See “Enabling Packages” on page 37 for instructions.
5. Using Designer, create a user-defined package to contain the connection, if you have not already
done so. For more information about managing packages for the adapter, see “ PeopleSoft
Adapter Package Management” on page 36.

Setting Up Your Adapter's Environment
You must set up your adapter's environment to enable the adapter to interface with the component
interfaces on your PeopleSoft system. Specifically, the adapter requires access to the following
PeopleSoft files:
psjoa.jar
pstools.properties

Compiled component interface class files
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The following procedures describe how to make these files accessible to the adapter.
Complete the steps in these procedures before you configure a new connection, before you update
an existing connection, or if you have added or changed CIs on your PeopleSoft system.
Because the adapter requires access to these PeopleSoft files (which are unique to each PeopleSoft
system), you can only enable one PeopleSoft Adapter connection at a time. If you need to configure
or modify another connection, you must complete the steps in this section again for that connection.
To set up the adapter's environment to work with your PeopleSoft system
1. Disable the WmPeopleSoftAdapter package. See “Disabling Packages” on page 38 if you need
instructions.
2. Copy your PeopleSoft system's psjoa.jar file to the Integration Server_directory
\packages\WmPeopleSoftAdapter\code\jars directory.
You can locate the psjoa.jar file in the directory where you installed the PeopleSoft system.
For example: PT8.42\web\psjoa\psjoa.jar.
3. Copy your PeopleSoft system's pstools.properties file to the Integration Server_directory
\packages\WmPeopleSoftAdapter\code\classes directory.
You can locate the pstools.properties file in one of the following locations, depending on the
version of PeopleTools you are using:
For PeopleTools 8.1x:
<PeopleSoft_directory>\web\jmac

where <PeopleSoft_directory> is the PeopleSoft home directory.
For PeopleTools 8.4x with WebSphere:
<WebSphere_directory>\installedApps\peoplesoft\applications\PORTAL\WEB-INF\
psftdocs\ps

where <WebSphere_directory> is the root directory for the WebSphere application server.
For example:
<WebSphere_directory>\installedApps\peoplesoft\applications\PORTAL\WEB-INF\
psftdocs\ps

For PeopleTools 8.4x with WebLogic:
<WebLogic_directory>\config\peoplesoft\applications\PORTAL\WEB-INF\psftdocs\ps

where <WebLogic_directory> is the root directory for the WebLogic application server.
For example:
<WebLogic_directory>\config\peoplesoft\applications\PORTAL\WEB-INF\psftdocs\ps
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4. Add your compiled component interface .class files to a .zip file called PeopleSoft.zip. For
instructions on generating and compiling your component interface files, see “Generating
Component Interface Class Files” on page 46.
Include the following directory structure in the .zip file: PeopleSoft\Generated\CompIntfc.
Then, add the PeopleSoft.zip file to the following location:
Integration Server_directory \packages\WmPeopleSoftAdapter\code\jars\
Note:
You can name the .zip file any name you want, but Software AG recommends you name
the file PeopleSoft.zip to simplify management of your CI class files. If you have multiple
.zip files in the directory and the same CI class files are present in both .zip files, the adapter
uses the first occurrence.
5. Enable the WmPeopleSoftAdapter package.

Generating Component Interface Class Files
To generate Component interface class files
1. Logon to the PeopleSoft Application Designer using the same user ID and password that you
will use with your PeopleSoft Adapter connection.
2. Test the component interface using the PeopleSoft Application Designer. If the test succeeds,
then continue with the procedure. If the test fails, check the following:
a. Check whether the CI has the correct authorization.
b. Make sure that all of the CI's properties are valid.
c. Re-generate the component interface.
See the PeopleBooks documentation for instructions on how to set authorization, validate
component interfaces, and create new component interfaces.
3. In the PeopleSoft Application Designer, select Build > PeopleSoft APIs. Then, on the Build
APIs Bindings screen:
a. Disable all of the options except the Java Classes Build option.
b. Specify the directory where the built Java APIs are located; for example,
c:\PT8.42\web\extapi.
c. Highlight the required component interface files or all files.
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d. Click OK.
4. Navigate to the directory where the Java files are located and compile all of the Java files using
the psjoa.jar file in classpath option. For example:
javac -classpath c:\PT8.42\web\psjoa\psjoa.jar c:\PT8.42\web\extapi\*.java

5. Move the compiled .class files to a directory accessible to the adapter, as described in “Setting
Up Your Adapter's Environment” on page 44.

Configuring Adapter Connections
When you configure PeopleSoft Adapter connections, you specify information that the Integration
Server uses to connect to a PeopleSoft system. You configure PeopleSoft Adapter connections
using the Integration Server Administrator.
To configure a connection
1. In the Adapters menu in the Integration Server Administrator navigation area, click PeopleSoft
Adapter.
2. On the Connections screen, click Configure New Connection.
3. On the Connection Types screen, click PeopleSoft Connection to display the Configure
Connection Type screen.
4. In the PeopleSoft Adapter Connection section, provide values for the following fields.
Parameter

Description/Action

Package

Package in which to configure the connection.
You must create the package using Designer before you can specify it for
this parameter. For general information about creating packages, see the
webMethods Service Development Help for your release.
Note:
Configure the connection in a user-defined package rather than in the
adapter's package. See “Package Management” on page 35 for other
important considerations when creating packages for use with the
PeopleSoft Adapter.

Folder Name

Folder in which to configure the connection.

Connection
Name

Name you want to give the connection. Connection names cannot have
spaces or use special characters reserved by the Designer. For more
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Parameter

Description/Action
information about the use of special characters in package, folder, and
element names, see the webMethods Service Development Help for your release.

5. In the Connection Properties section, provide values for the following fields:
Parameter

Description/Action

PeopleSoft
Application Host
Name or IP
Address

Host name or IP address of the machine on which your PeopleSoft
Application Server is running.

Port number of the PeopleSoft Application Server.
PeopleSoft
Application Server
Default value is 9000.
Port
User ID

User name that you use on your PeopleSoft Signon window.

Password

Password that you use on your PeopleSoft Signon window.

Domain Password Optional. Domain connection password to add an extra layer of security
between the application server domain and the connections created.
Language Code
(optional)

PeopleSoft language code that the adapter uses to create all PeopleSoft
sessions with locale-specific information.
Default: Blank. The PeopleSoft system will use the base Locale and base
tables for all transactions.
Note:
See “PeopleSoft Country Codes and Language Codes” on page 51 for
PeopleSoft Language Codes and equivalent ISO Locales.

Country Code
(optional)

PeopleSoft country code that the adapter uses to create all PeopleSoft
sessions with locale-specific information.
Default: Blank. The PeopleSoft system will use the base Locale and base
tables for all transactions.
See “PeopleSoft Country Codes and Language Codes” on page 51 for
PeopleSoft Language Codes and equivalent ISO Locales.

PeopleTools
Version

PeopleTools version of the backend PeopleSoft application server.
Default: PeopleTools version of the psjoa.jar file used.

Enable List Of All Enables the adapter service templates to provide a list of all available
CIs for you to choose when configuring a service.
Available CIs
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Parameter

Description/Action
If you select FALSE, you must type the exact name of the CI you want the
adapter service to use on the Component Interface tab when you
configure the adapter service.
If you select TRUE, each PeopleSoft Adapter service template displays a
list of all available CIs on the PeopleSoft system. You can select a CI from
the list when you configure the adapter service. Selecting this option has
the following effects on adapter service configuration and on connections:
The first time you configure an adapter service with the connection,
it might take a long time to generate a list of all available CIs.
Subsequent service configurations will not be affected.
It takes a longer amount of time to reconnect to the PeopleSoft
application server.
If the PeopleSoft system contains CIs with errors, all of the errors will
appear in the Integration Server console.
Note:
If you are using this adapter with PeopleTools 8.18 and there are
errors in the CIs, the list is not displayed. Software AG recommends
that you not select this option if you are using the adapter with
PeopleTools 8.18.
To configure adapter services successfully, all classes of the selected CI
must be included in the PeopleSoft.zip file that is located in the
WmPeopleSoftAdapter\code\jars directory.
If the CI is available in the list but is not included in the PeopleSoft.zip
file, you will receive the error "Can not find component interface…". For
more information about the PeopleSoft.zip file, see “Configuring Adapter
Connections” on page 47.

6. In the Connection Management Properties section, provide values for the following fields:
Field

Description/Action

Enable
Connection
Pooling

Enables the adapter to use connection pooling. Default: true.
See “Adapter Connections” on page 14 for more information about
connection pooling.
Note:
If you plan to enable connection pooling in a clustered environment,
consider the connection pool size. For details, see “Considerations When
Configuring Connections with Connection Pooling Enabled” on page 41.
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Field

Description/Action

Minimum Pool If connection pooling is enabled, this field specifies the minimum number
of connection objects that remain in the connection pool at all times. When
Size
the adapter creates the pool, it create this number of connections. Default:
1.
Maximum Pool Maximum number of connection objects that can exist in the connection pool.
When the connection pool has reached its maximum number of connections,
Size
the adapter will reuse any inactive connections in the pool or, if all
connections are active, it will wait for a connection to become available.
Default: 10.
Pool Increment If connection pooling is enabled, this field specifies the number of connections
by which the pool will be incremented if connections are needed, up to the
Size
maximum pool size. Default: 1.
Block Timeout If connection pooling is enabled, this field specifies the number of
milliseconds that the Integration Server will wait to obtain a connection with
the database before it times out and returns an error.
For example, you have a pool with Maximum Pool Size of 20. If you receive
30 simultaneous requests for a connection, 10 requests will be waiting for a
connection from the pool. If you set the Block Timeout to 5000, the 10
requests will wait for a connection for 5 seconds before they time out and
return an error. If the services using the connections require 10 seconds to
complete and return connections to the pool, the pending requests will fail
and return an error message stating that no connections are available.
If you set the Block Timeout value too high, you may encounter problems
during error conditions. If a request contains errors that delay the response,
other requests will not be sent. This setting should be tuned in conjunction
with the Maximum Pool Size to accommodate such bursts in processing.
Expire Timeout If connection pooling is enabled, this field specifies the number of
milliseconds that an inactive connection can remain in the pool before it is
closed and removed from the pool.
The connection pool will remove inactive connections until the number of
connections in the pool is equal to the Minimum Pool Size. The inactivity
timer for a connection is reset when the connection is used by the adapter.
If you set the Expire Timeoutvalue too high, you may have a number of
unused inactive connections in the pool. This consumes local memory and
a connection on your backend resource. This could have an adverse effect if
your resource has a limited number of connections.
If you set the Expire Timeoutvalue too low, performance could degrade
because of the increased activity of creating and closing connections. This
setting should be tuned in conjunction with the Minimum Pool Size to avoid
excessive opening/closing of connections during normal processing.
50

webMethods PeopleSoft Adapter Installation and User’s Guide 6.0

4 Adapter Connections

Field

Description/Action

Startup Retry Number of times that the system should attempt to initialize the connection
pool at startup if the initial attempt fails. Default: 0 (a single attempt).
Count
Number of seconds that the system should wait between attempts to initialize
the connection pool. This field is irrelevant if Startup Retry Count is 0.
Startup Backoff Timeout's default is 10.

Startup
Backoff
Timeout

7. Click Save Connection.
The connection you configured appears on the adapter's Connections screen and in Designer.
By default, when you configure a connection, it is not enabled. For information about enabling
connections, see “Enabling Adapter Connections” on page 55.

PeopleSoft Country Codes and Language Codes
The following table provides a partial list of country codes and language codes. To find a complete
list of country codes and language codes, see your pstools.properties file or check your PeopleSoft
system.
Language Code Country Code Description

Corresponding ISO Locale

CFR

CA

Canadian French

fr_CA

DUT

BE

Dutch

nl_BE

ENG

US

US English

en_US, en_GB

ESP

ES

Spanish

es_ES, es_AR, es_CO,es_MX

FRA

AR

French

fr_FR, fr_BE, fr_CH

GER

DE

German

de_DE, de_AT, de_AU, de_CH

GRK

EL

Greek

el_EL

INE

GB

International English en_GB

ITA

IT

Italian

it_IT, it_CH

JPN

JP

Japanese

ja_JP

KOR

KR

Korean

kr_KR

POR

BR

Portuguese

pt_BR
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Dynamically Changing a Service's Connection at Run Time
You can run a service using a connection other than the default connection that was associated
with the service when the service was created. To override the default, you must code your flow
to pass a value through the pipeline into a service's $connectionName field.
For example, you have a flow whose primary purpose is to update the data of a component interface
(CI) in a PeopleSoft system. However, you want the flow to have the capability to update the CI
in a test PeopleSoft system - with the decision of which PeopleSoft system to update to be made
programmatically at run time. The output signature of the flow's first service contains a field called
Target. The flow could branch based on the value in Target. If Target contains the value Production,
the second service in the flow would ignore $connectionName-thus using its default connection
to connect to (and then update) the production PeopleSoft system CI. However, if Target contains
the value Test, the second service in the flow would use the value in the $connectionName from
the pipeline and connect to (and then update) the test PeopleSoft system CI.
Keep in mind these restrictions when using dynamic connections:
Both connections - the default and override - must use the same PeopleSoft component interface.
The $connectionName field is present only in services created with Designer
For more information, see “Changing the Connection Associated with an Adapter Service at Run
Time” on page 15.

Viewing Adapter Connection Parameters
You can view a connection's parameters from the Integration Server Administrator or from Designer.

Viewing Connection Parameters from the Integration Server
Administrator
To view the parameters for a connection using the Integration Server Administrator
1. In the Adapters menu in the Integration Server Administrator navigation area, click PeopleSoft
Adapter.
When using the adapter with Integration Server 8.0 and later, you can sort and filter the list
of connections that appears on the Connections screen.
To sort information on the Connections screen, click the Up and Down arrows at the top
of the column you want to sort.
To filter the list of connections:
1. On the Connections screen, click Filter Connections.
2. Type the criterion by which you want to filter into the Filter criteria box. Filtering is
based on the node name, not the connection alias. To locate all connections containing
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specific alphanumeric characters, use asterisks (*) as wildcards. For example, if you
want to display all connections containing the string "abc", type *abc* in the Filter
criteria box.
3. Click Submit. The Connections screen displays the connections that match the filter
criteria.
4. To re-display all connections, click Show All Connections.
The Connections screen appears, listing all the current connections. You can control
the number of connections that are displayed on this screen. For more information, see
“Controlling Pagination” on page 29.
2. On the Connections screen, click the

icon for the connection you want to see.

The View Connection screen displays the parameters for the connection. For descriptions of
the connection parameters, see “Configuring Adapter Connections” on page 47.
3. Click Return to PeopleSoft Adapter Connections to return to the main connections screen.

Viewing Connection Parameters from Designer
To view the parameters for a connection using Designer
1. From the Designer navigation area, open the package and folder in which the connection is
located.
2. Double-click the connection you want to view.
The parameters for the connection appear on the Connection Information tab. For descriptions
of the connection parameters, see “Configuring Adapter Connections” on page 47.

Editing Adapter Connections
If you add or change the CIs on your PeopleSoft system, you must update your connection. You
edit adapter connections using the Integration Server Administrator.
To edit a connection
1. In the Adapters menu in the Integration Server Administrator navigation area, click PeopleSoft
Adapter.
2. Make sure that the connection is disabled before editing it. See “Disabling Adapter
Connections” on page 55 for instructions.
3. On the Connections screen, click the Edit icon
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The Edit Connection screen displays the current parameters for the connection. Update the
connection's parameters by typing or selecting the values you want to specify.
For descriptions of the connection parameters, see “Configuring Adapter Connections” on
page 47.
4. Click Save Changes to save the connection and return to the Connections screen.

Copying Adapter Connections
You can copy an existing PeopleSoft Adapter connection to configure a new connection with the
same or similar connection properties without having to re-type all of the properties for the
connection. You copy adapter connections using the Integration Server Administrator.
To copy a connection
1. In the Adapters menu in the Integration Server Administrator navigation area, click PeopleSoft
Adapter.
2. On the Connections screen, click the

icon for the connection you want to copy.

The Copy Connection screen displays the current parameters for the connection you want to
copy. Name the new connection, specify a Package Name and Folder Name, and edit any
connection parameters as needed by typing or selecting the values you want to specify.
Note:
When you copy a connection, the new connection does not save the password of the original
connection. You must enter and then retype the password before you can save the new
connection.
For descriptions of the connection parameters, see “Configuring Adapter Connections” on
page 47.
3. Click Save Connection to save the connection and return to the Connections screen.

Deleting Adapter Connections
If you no longer want to use a particular PeopleSoft Adapter connection, you can delete it by
following the instructions in this section. You delete adapter connections using the Integration
Server Administrator.
If you delete a PeopleSoft Adapter connection, the adapter services that are defined to use the
connection will no longer work. However, you can assign a different connection to an adapter
service and re-use the service. To do this, you use the built-in webMethods
servicepub.art.service:setAdapterServiceNodeConnection. For more information, see “Changing the
Connection Associated With an Adapter Service at Design Time” on page 15.
To delete a connection
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1. In the Adapters menu in the Integration Server Administrator navigation area, click PeopleSoft
Adapter.
2. Make sure that the connection is disabled before deleting. To disable the connection, click Yes
in the Enabled column and click OK to confirm. The Enabled column now shows No (disabled)
for the connection.
3. On the Connections screen, click

for the connection you want to delete.

The Integration Server deletes the adapter connection.

Enabling Adapter Connections
A PeopleSoft Adapter connection must be enabled before you can configure any adapter service
using the connection, or before an adapter service can use the connection at run time. You enable
adapter connections using the Integration Server Administrator.
Note:
When you reload a package that contains enabled connections, the connections will automatically
be enabled when the package reloads. If the package contains connections that are disabled,
they will remain disabled when the package reloads.
To enable a connection
1. In the Adapters menu in the Integration Server Administrator navigation area, click PeopleSoft
Adapter.
2. On the Connections screen, click No in the Enabled column for the connection you want to
enable.
The Integration Server Administrator enables the adapter connection and displays a
Yes in the Enabled column.

and

Disabling Adapter Connections
PeopleSoft Adapter connections must be disabled before you can edit or delete them. You disable
adapter connections using the Integration Server Administrator.
To disable a connection
1. In the Adapters menu in the Integration Server Administrator navigation area, click PeopleSoft
Adapter.
2. On the Connections screen, click Yes in the Enabled column for the connection you want to
disable.
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The adapter connection becomes disabled and you see a No in the Enabled column.
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Overview
This chapter describes how to configure and manage PeopleSoft Adapter services. For detailed
descriptions of the available PeopleSoft Adapter services, see “Adapter Services” on page 16.

Before Configuring or Managing Adapter Services
Important:
Make sure you have webMethods administrator privileges so that you can access the PeopleSoft
Adapter's administrative screens. For information about setting user privileges, see the
webMethods Integration Server Administrator’s Guide for your release.
To prepare to configure or manage PeopleSoft Adapter services
1. Start your Integration Server and the Integration Server Administrator, if they are not already
running.
2. Using the Integration Server Administrator, make sure the WmPeopleSoftAdapter package is
enabled. See “Enabling Packages” on page 37 for instructions.
3. Using the Integration Server Administrator, configure an adapter connection to use with the
adapter service. See “Configuring Adapter Connections” on page 47 for instructions.
4. Start Software AG Designer if it is not already running.
Note:
If you are using Designer, use the Service Development perspective. For more information,
see the webMethods Service Development Help for your release.
5. Using Designer, create a user-defined package to contain the service, if you have not already
done so. When you configure adapter services, you should always define them in user-defined
packages rather than in the WmPeopleSoftAdapter package. For more information about
managing packages for the adapter, see “Package Management” on page 35.

Configuring Get Services
Get services enable the adapter to retrieve a single CI record from a PeopleSoft database. For more
information about Get services, see “Get Services” on page 17. You configure PeopleSoft Adapter
services using Designer.
To configure a Get service
1. Review the steps in “Before Configuring or Managing Adapter Services” on page 58.
2. Start Designer.
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3. Perform the following:
a. Right-click the package in which the service should be contained and select New > Adapter
Service.
b. Select the parent namespace and type a name for the adapter service.
c. Click Next.
4. Select PeopleSoft Adapter as the adapter type and click Next.
5. Select the appropriate Adapter Connection Name and click Next.
6. From the list of available templates, select the Get template.
7. Click Finish.
The adapter service editor for the Get service appears. You can select the Adapter Settings
tab at any time to confirm adapter service properties such as the Adapter Name, Adapter
Connection Name, and Adapter Service Template, as necessary.
8. Select the Component Interface tab, if it is not already selected, to specify the PeopleSoft CI
to use with the Get service. Specify values for the following fields:
Parameter

Description/Action

Component Interface Specify the name of the CI with which the adapter service will
interface, as follows:
Name
If the Enable List Of All Available CIs parameter for this service's
associated adapter connection is set to TRUE, you can select the
CI from a list of all available CIs on the PeopleSoft system.
The list of CIs reflects all CIs on the PeopleSoft system. However,
the adapter service will only work if the CI's .class files are present
in the PeopleSoft.zip in the Integration Server directory. See
“Setting Up Your Adapter's Environment” on page 44 for details.
If the Enable List Of All Available CIs parameter for this service's
associated adapter connection is set to FALSE, you must type the
name of the CI. This field is case sensitive.
For more information about the Enable List Of All Available
CIsoption, see “Configuring Adapter Connections” on page 47.
If you want Designer to display an error if you select an invalid CI
name, you can turn on automatic validation of adapter services as
described in“Validating Adapter Service Values” on page 75.
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Parameter

Description/Action

Get History Items

Select this option if you want the service to get records that have
effective dates that are set to a past date.

9. Select the Key Fields tab and specify the CI's Get key fields that the service will use as input
fields to determine which record to return. Fields that you select on this tab will appear in the
adapter service's input signature within a document called ServiceNameInput, where ServiceName
is the name you specify for the service.
The tab contains the following information:
Parameter

Description/Action

CI Field Name

This column lists all Get key fields for the CI.

CI Field Type

This column lists the PeopleSoft data type for each Get key field.

Use Field

Select this option for each field you want to use as an input for the
service, or click the icon to select all of the fields. The service will
use the values of these fields to determine which record to return.
Each field you select on this tab will appear in the adapter service's
input signature (see the Input/Output tab) within a document called
ServiceNameInput, where ServiceName is the name you specify for the
service.

Input Field Name

When you choose a field on this tab, this column lists the webMethods
field name. Do not change the field name or the service will not work.

Input Field Type

This column lists the webMethods data type for each input field.

10. Select the Output Fields tab and specify the CI fields that the service will use as output fields.
The tab contains the following information:
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Parameter

Description/Action

CI Field Name

This column lists all available output fields for the CI.

CI Field Type

This column lists the PeopleSoft data type for each CI output field.

CI Record Name

This column lists the record names for all available records in the CI.
This column is provided as a convenience, enabling you to more easily
identify record names.

Use Field

Select this option for each field you want to use as an output field, or
click the icon to select all of the fields. The service will return CI
records containing these fields.
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Parameter

Description/Action
Each field that you select on this tab will appear in the adapter service's
output signature (see the Input/Output tab) within a document called
ServiceNameOutput, where ServiceName is the name you specify for
the service.

Output Field Name

When you choose a field on this tab, this column lists the webMethods
field name. Do not change the field name or the service will not work.

Output Field Type

This column lists the webMethods data type for each output field.

11. When using Designer the, Designer contains only the Adapter Settings and Input/Output
tabs. The information from the Audit and Permissions tabs appears in the Properties panel,
and the information from the Results tab appears in the Service Results panel (in Designer).
For more information see the webMethods Service Development Help for your release.
12. From the File menu, select Save.

Configuring Insert Services
Insert services enable the adapter to insert level 0 or higher CI records into a PeopleSoft database.
For more information about Insert services, see “Insert Services” on page 20. You configure
PeopleSoft Adapter services using Designer.
To configure an Insert service
1. Review the steps in “Before Configuring or Managing Adapter Services” on page 58.
2. Start Designer.
3. Perform the following:
a. Right-click the package in which the service should be contained and select New > Adapter
Service.
b. Select the parent namespace and type a name for the adapter service.
c. Click Next.
4. Select PeopleSoft Adapter as the adapter type and click Next.
5. Select the appropriate Adapter Connection Name and click Next.
6. From the list of available templates, select the Insert template.
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7. Click Finish.
The adapter service editor for the Insert service appears. You can select the Adapter Settings
tab at any time to confirm adapter service properties such as the Adapter Name, Adapter
Connection Name, and Adapter Service Template, as necessary.
8. Select the Component Interface tab, if it is not already selected, to specify the PeopleSoft
component interface to use with the Insert service. Specify a value for the following fields:
Parameter

Description/Action

Component Interface Specify the name of the CI with which the adapter service will
interface, as follows:
If the Enable List Of All Available CIs parameter for this service's
associated adapter connection is set to TRUE, you can select the
CI from a list of all available CIs on the PeopleSoft system.
The list of CIs reflects all CIs on the PeopleSoft system. However,
the adapter service will only work if the CI's .class files are copied
to the Integration Server directory. See “Setting Up Your Adapter's
Environment” on page 44 for details.
If the Enable List Of All Available CIs parameter for this service's
associated adapter connection is set to FALSE, you must type the
name of the CI. This field is case sensitive.
For more information about the Enable List Of All Available
CIsoption, see “Configuring Adapter Connections” on page 47.
If you want Designer to display an error if you select an invalid CI
name, you can turn on automatic validation of adapter services as
described in“Validating Adapter Service Values” on page 75.
9. On the Key Fields tab, you can view the list of key fields that the CI requires for input services.
The tab contains the following information:
Parameter

Description/Action

CI Field Name

This column lists all Create key fields for the CI.

CI Field Type

This column lists the PeopleSoft data type for each Create key field.

Input Field Name

This column lists the webMethods field names for the input fields.
When running this service, these fields must contain values for the
service to be able to create and insert a CI record.

Input Field Type

This column lists the webMethods data type for each input field.

10. Select the Input Fields tab and specify the CI fields that the service will use as input fields.
62

webMethods PeopleSoft Adapter Installation and User’s Guide 6.0

5 Adapter Services

The tab contains the following information:
Parameter

Description/Action

CI Field Name

This column lists all available input fields for the CI.

CI Field Type

This column lists the PeopleSoft data type for each CI input field.

CI Record Name

This column lists the record names for all available records in the CI.
This column is provided as a convenience, enabling you to more easily
identify record names.

CI Record Key

This column indicates whether the field is a key field for the CI record.
If this column contains a check mark, then the field is required for the
record indicated in the CI Record Name column.
You must select the CI Record Key fields and provide values for these
fields for each level 0 or higher record you are inserting into the
PeopleSoft database or PeopleSoft will return an error. You do not
have to provide values for level 1 or higher records that you are not
inserting.

Use Field

Select this option for each field you want to use as an input field, or
click the icon to select all of the fields. You must select the CI record
keys for each record the service will insert.
Each field that you select on this tab will appear in the adapter service's
input signature (see the Input/Output tab) within a document called
ServiceNameInput.CreateKeyFields, where ServiceName is the name
you specify for the service.

Input Field Name

When you choose a field on this tab, this column lists the webMethods
field name. Do not change the field name or the service will not work.
The insert service can use any of the fields selected on this tab when
inserting a record. However, the service must contain values for the
CI record key fields for each record the service will insert.

Input Field Type

This column lists the webMethods data type for each input field.

11. Select the Output Fields tab and specify whether the service will return a status. The tab
contains the following information:
Parameter

Description/Action

Status Field

This column shows the STATUS output field.

Use Field

Select this option if you want the service to return a status.
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Parameter

Description/Action
If you choose to use the STATUS field, the field will appear as an
output field on the service's output signature (see the service's
Input/Output tab).

Output Field Name

If you choose to use the STATUS field, this column lists the
webMethods field name.

Output Field Type

This column lists the webMethods data type for the STATUS output
field.

12. When using Designer, the Designer contains only the Adapter Settings and Input/Output
tabs. The information from the Audit and Permissions tabs appears in the Properties panel,
and the information from the Results tab appears in the Service Results panel (in Designer).
For more information see the webMethods Service Development Help for your release.
13. From the File menu, select Save.

Configuring Find Services
Find services enable the adapter to find a set of CI records in a PeopleSoft database based on
user-defined search criteria. For more information about Find services, see “Find Services” on
page 19. You configure PeopleSoft Adapter services using Designer.
To configure a Find service
1. Review the steps in “Before Configuring or Managing Adapter Services” on page 58.
2. Start Designer.
3. Perform the following:
a. Right-click the package in which the service should be contained and select New > Adapter
Service.
b. Select the parent namespace and type a name for the adapter service.
c. Click Next.
4. Select PeopleSoft Adapter as the adapter type and click Next.
5. Select the appropriate Adapter Connection Name and click Next.
6. From the list of available templates, select the Find template.
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7. Click Finish.
The adapter service editor for the Find service appears. You can select the Adapter Settings
tab at any time to confirm adapter service properties such as the Adapter Name, Adapter
Connection Name, and Adapter Service Template, as necessary.
8. Select the Component Interface tab to specify the PeopleSoft component interface to use with
the Find service. Specify a value for the following field:
Parameter

Description/Action

Component Interface Specify the name of the CI with which the adapter service will
interface, as follows:
If the Enable List Of All Available CIs parameter for this service's
associated adapter connection is set to TRUE, you can select the
CI from a list of all available CIs on the PeopleSoft system. The
list of CIs reflects all CIs on the PeopleSoft system. However, the
adapter service will only work if the CI's .class files are copied to
the Integration Server directory. See “Setting Up Your Adapter's
Environment” on page 44 for details.
If the Enable List Of All Available CIs parameter for this service's
associated adapter connection is set to FALSE, you must type the
name of the CI. This field is case sensitive.
For more information about the Enable List Of All Available
CIsoption, see “Configuring Adapter Connections” on page 47. If you
want Designer to display an error if you select an invalid CI name,
you can turn on automatic validation of adapter services as described
in“Validating Adapter Service Values” on page 75.
9. Select the Key Fields tab and specify the CI key fields that the service will use as input fields
to determine which CI records to retrieve.
The tab contains the following information:
Parameter

Description/Action

CI Field Name

This column lists all Find key fields for the CI.

CI Field Type

This column lists the PeopleSoft data type for each Find key field.

Use Field

Select this option for each field you want to use as an input for the
service, or click the icon to select all of the fields. The service will
use the values of these fields to determine which CI records to find.
Fields that you select on this tab will appear in the adapter service's
input signature (see the Input/Output tab) within a document called
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Parameter

Description/Action
ServiceNameInput, where ServiceName is the name you specify for the
service.

Input Field Name

When you choose a field on this tab, this column lists the webMethods
field name. Do not change the field name or the service will not work.

Input Field Type

This column lists the webMethods data type for each input field.

10. Select the Output Fields tab and specify the CI fields that the service will return as output
fields.
The tab contains the following information:
Parameter

Description/Action

CI Field Name

This column lists all available fields for the CI

CI Field Type

This column lists the PeopleSoft data type for each CI field.

CI Record Name

This column lists the record names for all available records. This
column is provided as a convenience to more easily identify record
names.

Use Field

Select this option for each field you want to use as an output field, or
click the icon to select all of the fields.
Fields that you select on this tab will appear in the adapter service's
output signature (see the Input/Output tab) within a document called
ServiceNameOutput, where ServiceName is the name you specify for
the service.

Output Field Name

When you choose a field on this tab, this column lists the webMethods
field name.

Output Field Type

This column lists the webMethods data type for each output field.

11. When using Designer the, Designer contains only the Adapter Settings and Input/Output
tabs. The information from the Audit and Permissions tabs appears in the Properties panel,
and the information from the Results tab appears in the Service Results panel (in Designer).
For more information see the webMethods Service Development Help for your release.
12. From the File menu, select Save.
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Configuring Update Services
Update services enable the adapter to update an existing level 0 or higher CI record in a PeopleSoft
database. For more information about Update services, see “Update Services” on page 22. You
configure PeopleSoft Adapter services using Designer.
To configure an Update service
1. Review the steps in “Before Configuring or Managing Adapter Services” on page 58.
2. Start Designer.
3. Perform the following:
a. Right-click the package in which the service should be contained and select New > Adapter
Service.
b. Select the parent namespace and type a name for the adapter service.
c. Click Next.
4. Select PeopleSoft Adapter as the adapter type and click Next.
5. Select the appropriate Adapter Connection Name and click Next.
6. From the list of available templates, select the Update template.
7. Click Finish.
The adapter service editor for the Update service appears. You can select the Adapter Settings
tab at any time to confirm adapter service properties such as the Adapter Name, Adapter
Connection Name, and Adapter Service Template, as necessary.
8. Select the Component Interface tab, if it is not already selected, to specify the PeopleSoft
component interface to use with the Update service. Specify values for the following fields:
Parameter

Description/Action

Component Interface Specify the name of the CI with which the adapter service will
interface, as follows:
If the Enable List Of All Available CIs parameter for this service's
associated adapter connection is set to TRUE, you can select the
CI from a list of all available CIs on the PeopleSoft system.
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Parameter

Description/Action
The list of CIs reflects all CIs on the PeopleSoft system. However,
the adapter service will only work if the CI's .class files are copied
to the Integration Server directory. See “Setting Up Your Adapter's
Environment” on page 44 for details.
If the Enable List Of All Available CIs parameter for this service's
associated adapter connection is set to FALSE, you must type the
name of the CI. This field is case sensitive.
For more information about the Enable List Of All Available
CIsoption, see “Configuring Adapter Connections” on page 47.
If you want Designer to display an error if you select an invalid CI
name, you can turn on automatic validation of adapter services as
described in“Validating Adapter Service Values” on page 75.

Interactive Mode

Select this option if you want the service to emulate an online
component. That is, select this option if you want the service to apply
values and run PeopleSoft business rules immediately. If you do not
select this option, PeopleSoft queues the items and runs the business
rules later, as a single step.

Get History Items

Select this option if you want the service to access records that have
effective dates that are set to a past date.

Edit History Items

Select this option if you want the service to be able to update records
with effective dates that are set to a past date.
To use this option, you must also select the Get History Items option.
Note:
For PeopleTools versions 8.18 and 8.19, the Edit History Items
feature is not supported. If you are using PeopleTools versions 8.18
or 8.19, you only need to select the Get History Items option if you
want the service to update records with effective dates that are set
to a past date.

Effective Date
Processing

Select this option if you want the update service to access and update
effective-dated level 1 or higher records according to date. See
“Effective Date Processing” on page 24 for a description of how the
Update service uses effective date processing.
To use this option, you must also select the Get History Items and
Edit History Items options.

9. Select the Key Fields tab and specify the CI key fields that the service will use to identify the
record to update.
The tab contains the following information:
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Parameter

Description/Action

CI Field Name

This column lists all Get key fields for the CI.

CI Field Type

This column lists the PeopleSoft data type for the Get field.

Use Field

Select this option for each field you want to use as an input for locating
the record to update, or click the icon to select all of the fields.
Fields that you select on this tab will appear in the adapter service's
input signature (see the Input/Output tab) within a document called
ServiceNameInput.LookupFields, where ServiceName is the name you
specify for the service.

Input Field Name

When you choose a field on this tab, this column lists the webMethods
field name.

Input Field Type

This column lists the webMethods data type for each input field.

10. Select the Update Fields tab and specify the CI key fields that the service will use to update
the record.
The tab contains the following information:
Parameter

Description/Action

CI Field Name

This column lists all available fields for the CI.

CI Field Type

This column lists the PeopleSoft data type for the field.

Use Field

Select this option for each field you want to use as an input for
updating the record, or click the icon to select all of the fields.
Fields that you select on this tab will appear in the adapter service's
input signature (see the Input/Output) within a document called
ServiceNameInput.UpdateFields, where ServiceName is the name you
specify for the service.

Input Field Name

When you choose a field on this tab, this column lists the webMethods
field name.

Input Field Type

This column lists the webMethods data types for the service's CI input
fields.

11. Select the Output Fields tab and specify whether the service will return a status.
The tab contains the following information:
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Parameter

Description/Action

Status Field

This column shows the STATUS output field.

Use Field

Select this option if you want the service to return a status.
If you choose to use the STATUS field, the field will appear as an
output field on the service's Input/Output tab.

Output Field Name

If you choose to use the STATUS field, this column lists the
webMethods field name.

Output Field Type

This column lists the webMethods data type for the STATUS output
field.

12. When using Designer, the Designer contains only the Adapter Settings and Input/Output
tabs. The information from the Audit and Permissions tabs appears in the Properties panel,
and the information from the Results tab appears in the Service Results panel (in Designer).
For more information see the webMethods Service Development Help for your release.
13. From the File menu, select Save.

Configuring Delete Row Services
Delete Row services enable the adapter to delete a level 1 or higher CI record from a PeopleSoft
database. For more information about Delete Row services, see “Delete Row Services” on page 25.
You configure PeopleSoft Adapter services using Designer.
To configure a Delete Row service
1. Review the steps in “Before Configuring or Managing Adapter Services” on page 58.
2. Start Designer.
3. Perform the following:
a. Right-click the package in which the service should be contained and select New > Adapter
Service.
b. Select the parent namespace and type a name for the adapter service.
c. Click Next.
4. Select PeopleSoft Adapter as the adapter type and click Next.
5. Select the appropriate Adapter Connection Name and click Next.
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6. From the list of available templates, select the Delete Row template.
7. Click Finish.
The adapter service editor for the Delete Row service appears. You can select the Adapter
Settings tab at any time to confirm adapter service properties such as the Adapter Name,
Adapter Connection Name, and Adapter Service Template, as necessary.
8. Select the Component Interface tab to specify the PeopleSoft component interface to use with
the Insert service. Specify values for the following fields:
Parameter

Description/Action

Component Interface Specify the name of the CI with which the adapter service will
interface, as follows:
If the Enable List Of All Available CIs parameter for this service's
associated adapter connection is set to TRUE, you can select the
CI from a list of all available CIs on the PeopleSoft system.
The list of CIs reflects all CIs on the PeopleSoft system. However,
the adapter service will only work if the CI's .class files are copied
to the Integration Server directory. See “Setting Up Your Adapter's
Environment” on page 44 for details.
If the Enable List Of All Available CIs parameter for this service's
associated adapter connection is set to FALSE, you must type the
name of the CI. This field is case sensitive.
For more information about the Enable List Of All Available
CIsoption, see “Configuring Adapter Connections” on page 47. If you
want Designer to display an error if you select an invalid CI name,
you can turn on automatic validation of adapter services as described
in“Validating Adapter Service Values” on page 75.
Interactive Mode

Select this option if you want the service to emulate an online
component. That is, select this option if you want the service to apply
values and run PeopleSoft business rules immediately, or whether
you want the service to queue the items and run the business rules
later, in a single step.

Get History Items

Select this option if you want the service to get records that have
effective dates that are set to a past date.

Edit History Items

Select this option if you want the service to be able to modify records
with effective dates that are set to a past date.
To use this option, you must also select the Get History Items option.
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9. Select the Lookup Key Fields tab and specify the CI key fields that the service will use to
locate the level 0 record from which you want to delete level 1 or higher records.
The tab contains the following information:
Parameter

Description/Action

CI Field Name

This column lists all Get key fields that you can use to identify records
for the CI.

CI Field Type

This column lists the PeopleSoft data type for the CI Get field name.

Use Field

Select this option for each field you want to use as an input for locating
the level 0 record, or click the icon to select all of the fields.
Fields that you select on this tab will appear in the adapter service's
input signature (see the Input/Output tab) within a document called
ServiceNameInput.LookupFields, where ServiceName is the name you
specify for the service.

Input Field Name

If you choose to use a CI field, this column lists the webMethods field
name.

Input Field Type

This column lists the webMethods data types for the service's CI input
fields.

10. Select the Delete Key Fields tab and specify the CI fields that the service will use to delete
level 1 or higher records. That is, the service uses the delete key fields to identify the level 1
or higher records to delete.
The tab contains the following information:
Parameter

Description/Action

CI Field Name

This column lists all available key fields for the CI.

CI Field Type

This column lists the PeopleSoft data type for the CI field.

Use Field

Select this option for each field you want to use as an input field to
identify the record to delete, or click the icon to select all of the
fields.
Fields that you select on this tab will appear in the adapter service's
input signature (see the Input/Output tab) within a document called
ServiceNameInput.DeleteKeys, where ServiceName is the name you
specify for the service.

Delete Row Key
Name
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webMethods PeopleSoft Adapter Installation and User’s Guide 6.0

5 Adapter Services

Parameter

Description/Action
Fields you select here are included as output fields on the service's
Input/Output tab.

Delete Row Key Type This column lists the webMethods data types for the delete key fields.
11. Select the Output Fields tab and specify whether the service will return a status.
The tab contains the following information:
Parameter

Description/Action

Status Field

This column shows the STATUS output field.

Use Field

Select this option if you want the service to return a status.
If you choose to use the STATUS field, the field in the service's output
signature (see the Input/Output tab).

Output Field Name

If you choose to use the STATUS field, this column lists the
webMethods field name.

Output Field Type

This column lists the webMethods data type for the STATUS output
field.

12. When using Designer, the Designer contains only the Adapter Settings and Input/Output
tabs. The information from the Audit and Permissions tabs appears in the Properties panel,
and the information from the Results tab appears in the Service Results panel (in Designer).
For more information see the webMethods Service Development Help for your release.
13. From the File menu, select Save.

Testing Adapter Services
You use Designer to test adapter services.
For more information about testing and debugging services, see the webMethods Service Development
Help for your release.
To test adapter services
1. Review the steps in “Before Configuring or Managing Adapter Services” on page 58.
2. In Designer, expand the package and folder that contain the service you want to test.
3. Double-click the service you want to test.
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Designer displays the configured service in the service template's Adapter Service Editor.
4. Select Run > Run As > Run Service.
5. For every service input field, you will be prompted to enter an input value. Enter a value for
each input field and then click OK.
6. Click the Service Result tab (in Designer) to view the output from this service.

Viewing Adapter Services
You use Designer to view adapter services.
To view a service
1. Review the steps in “Before Configuring or Managing Adapter Services” on page 58.
2. In Designer, expand the package and folder that contain the service you want to view.
3. Double-click the service you want to view.
Designer displays the configured service in the service template's Adapter Service Editor.

Editing Adapter Services
You use Designer to edit adapter services.
To edit an adapter service
1. In Designer, browse to and open the adapter service that you want to edit.
2. Double-click the service that you want to edit.
Designer displays the adapter service in the service template's Adapter Service Editor.
3. Do one of the following:
If you have the VCS Integration feature enabled, right-click the service and select Check
Out.
If you do not have the VCS Integration feature enabled, right-click the service and select
Lock for Edit.
If you are using the local service development feature, from the Team menu in Designer,
select the appropriate option to check out the service. The options available in the Team
menu depend on the VCS client that you use.
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4. Modify the values for the adapter service's parameters as needed. For detailed descriptions of
the service's parameters, see the section on configuring a service for the specific type of service
you want to edit.
5. After you complete your modifications, save the service and do one of the following:
If you have the VCS Integration feature enabled, right-click the service and select Check
In. Enter a check-in comment and click OK.
If you do not have the VCS Integration feature enabled, right-click the service and select
Unlock.
If you are using the local service development feature, from the Team menu in Designer,
select the appropriate option to check in the service. The options available in the Team
menu depend on the VCS client that you use.
6. Save the service.

Deleting Adapter Services
You use Designer to delete adapter services.
To delete a service
1. Review the steps in “Before Configuring or Managing Adapter Services” on page 58.
2. In Designer, expand the package and folder that contain the service you want to delete.
3. Right-click the service and click Delete.

Validating Adapter Service Values
Designer enables the PeopleSoft Adapter to validate user-defined data for adapter services at
design time. You can validate the values for a single adapter service or you can configure Designer
to always validate the values for adapter services. Both options could potentially slow your
design-time operations.
When you enable data validation for a single adapter service, Designer compares the service values
against the resource data that has already been fetched from the selected adapter.
If you select the option to always validate values for adapter services, it will do so for all
webMethods WmART-based adapters installed on the Integration Server.
For more information about the Adapter Service/Notification Editor and other Designer menu
options and toolbar icons, see the webMethods Service Development Help for your release.
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Validating Values for a Single Adapter Service
To validate adapter service values for a single adapter service
1. Review the steps in “Before Configuring or Managing Adapter Services” on page 58.
2. In Designer, expand the package and folder that contain the service for which you want to
enable automatic validation.
3. Double-click the service for which you want to validate the data.
Designer displays the configured adapter service in the service template's Adapter Service
Editor.
4. Click the

icon.

Note:
This icon is available only when the Automatic data validation option is disabled.
Designer opens a connection with the PeopleSoft system. If the CI name does not exactly match
the name of a CI on the PeopleSoft system, or if you do not have the compiled .class files on
your Integration Server, you will receive an error.

Validating Values for All Adapter Services
To validate adapter service values for all adapter services
1. Review the steps in “Before Configuring or Managing Adapter Services” on page 58.
2. Start Designer.
3. Select the Window > Preferences > Software AG > Service Development > Adapter
Service/Notification Editor item.
4. Enable the Automatic data validation option.
5. Click OK.

Reloading Adapter Values
Designer enables the PeopleSoft Adapter to reload and validate user-defined data for adapter
services at design time. You can reload values for a single adapter service or you can configure
Designer so it automatically reloads the values for adapter services. Both options could potentially
slow your design-time operations.
76

webMethods PeopleSoft Adapter Installation and User’s Guide 6.0

5 Adapter Services

When you reload adapter values for a single adapter service, Designer compares the service values
against the resource data that has already been fetched from the selected adapter.
If you select the option to always reload values for adapter services, it will do so for all webMethods
WmART-based adapters installed on the Integration Server.
For more information about the Adapter Service/Notification Editor, other menu options, and
toolbar icons, see the webMethods Service Development Help for your release.

Reloading Values for a Single Adapter Service
To reload the adapter values for a single adapter service
1. Review the steps in “Before Configuring or Managing Adapter Services” on page 58.
2. InDesigner, expand the package and folder that contain the service for which you want to
enable automatic validation.
3. Double-click the service for which you want to validate the data.
Designer displays the configured adapter service in the service template's Adapter Service
Editor.
4. Click the

icon.

Note:
This icon is available only when the Automatic polling of adapter metadata option is
disabled.

Reloading Values for All Adapter Services
To reload adapter values for all adapter services
1. Review the steps in “Before Configuring or Managing Adapter Services” on page 58.
2. Start Designer.
3. Select the Window > Preferences > Software AG > Service Development > Adapter
Service/Notification Editor item.
4. Enable theAutomatic polling of adapter metadata option.
5. Click OK.
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Overview
This chapter provides instructions for creating PeopleSoft-to-webMethods (outbound) transaction
services. To create PeopleSoft-to-webMethods transactions, you must set up your PeopleSoft Web
server for outbound transactions, and you must set up your Integration Server to handle the
messages as they arrive from PeopleSoft. This chapter provides detailed instructions for those
steps. Additionally, this chapter provides information about how to configure your PeopleSoft
system to communicate to the Integration Server using SSL, and describes how to monitor your
outbound PeopleSoft request messages at run time.
For a detailed description of PeopleSoft-to-webMethods communications, see “PeopleSoft-towebMethods Communications” on page 27.
Note:
For PeopleSoft-to-webMethods communications, the PeopleSoft Adapter supports only the
PeopleTools versions specified in the webMethods Adapters System Requirements .

Setting Up the PeopleSoft Web Server for Outbound
Transactions
To set up the PeopleSoft Web server to enable outbound communications to webMethods, perform
the following steps:
Step

See

1

“Creating Messages for Use with the PeopleSoft Adapter ” on page 80

2

“Configuring the Integration Gateway” on page 81

3

“Configuring a Node” on page 81

4

“Writing a PeopleCode Program for use with PeopleSoft Events” on page 89

Note:
Before setting up the PeopleSoft Web server, check the PeopleSoft server status and make sure
the PUBSUB group is running. For details, see the PeopleBooks PeopleSoft Server Tools
Administration document.

Creating Messages for Use with the PeopleSoft Adapter
For PeopleSoft-to-webMethods communications, you must have a request message for outbound
asynchronous transactions and you must have a request message and a reply message for outbound
synchronous transactions.
You can use existing messages or you can create new messages. Use the PeopleSoft Application
Designer to create the messages and their properties. See the PeopleBooks documentation for
information about creating messages.
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Configuring the Integration Gateway
To configure the Integration Gateway to communicate with webMethods
1. Sign on to PeopleSoft by launching your browser and going to the following URL:
http://App_Server_Hostname:Port_Number/ps/signon.html
where App_Server_Hostname refers to WebLogic or WebSphere, as appropriate, and Port_Number
refers to the port number of the application server.
Example: http://parts.west.smithco.com:8080/ps/signon.html
2. From the PeopleSoft menu, click the PeopleTools link.
3. Click Integration Broker, and then click Gateways.
4. You can select an existing Integration Gateway ID or add a new Integration Gateway.
To select an existing Integration Gateway ID, click the Find an Existing Value tab, enter
a search parameter to identify the Gateway ID, and then select the Gateway ID you want
to use.
To add a new Integration Gateway:
1. Click the Add a New Value tab, type a name for the new Gateway, and then click Add.
2. Enable the Local Gateway option. This Gateway must be the local Gateway.
3. In Gateway URL, go to the URL for the selected Gateway's listening connector, as
follows:
http://App_Server_Hostname:Port_Number/PSIGW/PeopleSoftListeningConnector
where App_Server_Hostname refers to WebLogic or WebSphere, as appropriate, and
Port_Number refers to the port number of the application server.
Example: http://parts.west.smithco.com:8080/PSIGW/PeopleSoftListeningConnector
4. Click Load to load all available target connectors and verify that HTTPTARGET is in
the list of connector IDs for the Gateway.
5. Click Save.

Configuring a Node
To configure a PeopleSoft node, perform the following basic steps:
1. “Define a Node” on page 82
2. “Define a Connector” on page 83
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3. “Test the Node” on page 85
4. “Define a Transaction” on page 85 or “Define a Service Operation” on page 88
Important:
If you are using PeopleTools versions 8.41, 8.42, 8.43, 8.44, 8.45, 8.46, or 8.47, you define a
transaction. If you are using PeopleTools version 8.48 or 8.49, you define a service operation.

Define a Node
You can define a node by using an existing node or adding a new one.
Use an Existing Node
To define a node by using an existing node
1. Launch your browser and sign on to PeopleSoft.
2. From the PeopleSoft menu, click PeopleTools > Integration Broker > Node Definitions.
3. Select an existing node as follows:
a. Click the Find an Existing Value tab and search for the node you want to use.
b. Select the node.
4. Proceed with defining a connector. For instructions on how to define a connector, see “Define
a Connector” on page 83.
Use a New Node
To define a node by adding a new node
1. Launch your browser and sign on to PeopleSoft.
2. From the PeopleSoft menu, click PeopleTools > Integration Broker > Node Definitions.
3. Add a new node as follows:
a. Click the Add a New Value tab.
b. Type the Node Name.
c. Click Add.
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d. On the Node Info tab, specify the following parameters for the node. If a field or option is
not listed in the table, you do not need to enter a value for the field or enable the option.
For detailed field definitions, see the PeopleSoft documentation.
Field

Action/Description

Description

Type descriptive information about the node. Optional.

Company ID

Type your company ID.

Node Type

Select PIA.

Active Node

Enable this option.

Routing Type

Select Implicit.

Authentication
Option

Select None if you do not require Authentication for this node, or
select Certificate if you plan to use SSL with this node.

e. Click Save.
4. Proceed with defining a connector. For instructions on how to define a connector, see “Define
a Connector” on page 83.

Define a Connector
To define a connector
1. Launch your browser and sign on to PeopleSoft.
2. From the PeopleSoft menu, click PeopleTools > Integration Broker > Node Definitions >
Connectors.
3. Verify the Node Name.
4. Select the Gateway ID for the gateway that you configured in “Configuring the Integration
Gateway” on page 81.
5. Select HTTPTARGET as the Connector ID.
6. Type the following values in the Properties panel. For detailed field descriptions, see the
PeopleSoft documentation.
Field

Action/Description

HEADER

Property Name: sendUncompressed
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Field

Action/Description
Required: Enable this option.
Value: Y
Data Type: STRING
Description: A descriptive text entry is optional.

HTTPPROPERTY Property Name: Method
Required: Enable this option.
Value: POST
Data Type: STRING
Description: A descriptive text entry is optional.
PRIMARYURL

Property Name: URL
Required: Enable this option.
Value: The URL that points to the Integration Server, as follows:
http<s>://IntegrationServer_Host:Port/invoke/
wm.adapter.peoplesoft.outbound.
sample:receiveXML

For example:
http://localhost:5555/invoke/wm.adapter.
peoplesoft.outbound.sample:receiveXML

Data Type: STRING
Description: A descriptive text entry is optional.
HEADER

Property Name: Authorization
Required: Enable this option.
Value: The user name and password used as Authorization to start the
Integration Server.
Use the following format, along with the encoding flow service listed
below, to encode the user name and password:
"Basic" (+ Base64Encode service using username + ":" + password)
To encode the username and password, use the following utility flow
service:
wm.adapter.peoplesoft.outbound.utils.encoding
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Field

Action/Description
where the input for the encoding service is a string constructed from the
username and password, as follows:
"username"+":"+"password"
For example, if the username is "name" and the password is "pwd", the
input for the encoding service would be "name:pwd".
The result of encoding flow service for these values would be
"bmFtZTpwd2Q". Thus, the value of the Authorization field would be
"Basic bmFtZTpwd2Q".
Data Type: Leave this field blank.
Description: A descriptive text entry is optional.

7. Click Save.
8. You can test the node to check if the connection is getting through the gateway. For instructions
on how to test the node, see “Test the Node” on page 85.
9. Proceed with defining a transaction or a service operation. For instructions, see “Define a
Transaction” on page 85 and “Define a Service Operation” on page 88.

Test the Node
To test whether the node's connection is getting through the gateway, ping the node.
To ping the node
1. From the PeopleSoft menu, click Integration Broker > Monitor Messages.
2. Select the Node Status tab.
3. In the Message Node Name field, specify the node name and then click Ping Node.

Define a Transaction
If you are using PeopleTools versions 8.41, 8.42, 8.43, 8.44, 8.45, 8.46, or 8.47, define a transaction
using the following procedure.
To define the node’s transaction
1. Launch your browser and sign on to PeopleSoft.
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2. From the PeopleSoft menu, click PeopleTools > Integration Broker > Node Definitions >
Transactions.
3. Choose an existing transaction or add a new transaction.
To add a new transaction:
a. ClickAdd Transaction.
b. From the Add a New Value tab, provide values for the following fields. For detailed field
descriptions, see your PeopleSoft documentation.
Field

Action/Description

Node Name

Select the name of the node you defined earlier.

Effective Date

Type the date the transaction should go into effect.

Transaction Type Select Outbound Synchronous.
For more information about Outbound Synchronous transactions,
see the PeopleSoft documentation.
Request Message Select the name of the request message.
Request Message Select the message version.
Version
c. Click Add.
4. On the Transaction Detail tab, provide values for the following fields. For detailed field
descriptions, see your PeopleSoft documentation.
Field

Action/Description

Node Name

Verify the name of the node you defined earlier.

Effective Date

Verify the date the transaction should go into effect.

Status

Select Active.

Transaction Type Verify that the transaction type is OutSync.
Request Message Verify the name of the request message.
Request Message Verify the message version.
Version

86

Routing Type

Select Implicit.

Override
Connector

Disable this option.
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Field

Action/Description

Comments

Optional descriptive text entry.

5. Click Transactions > Save.
6. On the Messages tab, provide values for the following fields. For detailed field descriptions,
see the PeopleSoft documentation.
Field

Action/Description

Node Name

Verify the name of the node you defined earlier.

Effective Date

Verify the date the transaction should go into effect.

Status

Verify that the message status is active.

Log Message
Detail

Enable this option if you want to see the transaction's full message details
logged in the PeopleSoft Integration Broker Monitor.

Request Message:
Name

Verify the name of the request message.

Version

Verify the request message version.

External Name

Optional entry.

Response Message:
Name

Select the name of the response message.

Version

Select the response message version.

External Name

Optional entry.

7. Click Save.
After you complete these steps, you should have a node defined with connectors and transactions
similar to the following example:
Name

Value

Node

WEBM_NODE

GatewayID

LOCAL

ConnectorID

HTTPTARGET

Transactions

OutSync
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Name

Value

Request Message REP_SYNC, version_1
Response Message WEBM_REPLY, version_1

Define a Service Operation
If you are using PeopleTools version 8.48 or 8.49, define a service operation using the following
procedure.
To define the node’s service operation
1. Launch your browser and sign on to PeopleSoft.
2. From the PeopleSoft menu, click PeopleTools > Integration Broker > Service Operations.
3. Select an existing service operation or add a new service operation.
To add a new service operation:
a. Click the Add Service Operationtab.
b. Provide values for the following fields. For detailed field descriptions, see your PeopleSoft
documentation.
Field

Action/Description

Service

Select the name of the service you defined earlier.

Service Operation Enter the name of the service operation. For example, WEBM_SO.
Operation Type

Select Synchronous.
For more information about Synchronous transactions, see the
PeopleSoft documentation.

c. Click Add.
d. On the General tab, provide values for the following fields. For detailed field descriptions,
see your PeopleSoft documentation.
Field

Action/Description

Operation
Description

Enter the description of the operation.

Request Message Select the message version.
Version
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Field

Action/Description

Select the message version.
Response
Message Version
e. Click Save.
4. On the Routing tab, enter the Routing Name. For example, WEBM_ROUTING.
5. Click Add.
6. On the Routing Definitions tab, provide values for the following fields. For detailed field
descriptions, see the PeopleSoft documentation.
Field

Action/Description

Sender Node

Should be the default local node. For example, PSFT_CR.

Receiver Node

Verify the name of the node you defined earlier. For example,
WEBM_NODE. WEBM_NODE is the node representing the Integration
Server.

Status

Verify that the message status is active.

Log Detail

Select an option.

7. Click Save.
After you complete these steps, you should have a node defined with connectors and service
operations similar to the following example:
Name

Value

Node

WEBM_NODE

GatewayID

LOCAL

ConnectorID

HTTPTARGET

Service Operation

WEBM_SO

Routing Name

WEBM_ROUTING

Writing a PeopleCode Program for use with PeopleSoft Events
For the PeopleSoft Adapter's outbound transactions, you use the PeopleCode Editor to create a
PeopleCode program for use with the component's SavePreChange or SavePostChange event.
PeopleSoft calls SavePreChange events before any database updates and calls SavePostChange events
after any database updates.
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For an overview of how the PeopleSoft Adapter uses PeopleCode programs, see “PeopleSoft-towebMethods Communications” on page 27. For more details on PeopleCode events, see your
PeopleSoft documentation.
To create a PeopleCode Program that sends a message to the node
1. Start the PeopleSoft Application Designer. You must use the PeopleSoft Application Designer
to view, edit, or create PeopleCode.
2. Open the component that has the request message attached to the SavePreChange or Save
PostChange event.
3. View the PeopleCode for the selected component. See your PeopleSoft documentation if you
need instructions on using the PeopleCode Editor.
4. If you are using PeopleTools versions 8.41, 8.42, 8.43, 8.44, 8.45, 8.46, or 8.47, select the event
(for example, SavePostChange), and type the following code in the PeopleCode Editor:
Local Message &request, &response;
Local Rowset &rep;
&rep = GetLevel0();
&request = CreateMessage(Message.REP_SYNC);
&request.CopyRowsetDelta(&rep);
&response = &request.SyncRequest(Node.WEBM_NODE);

where REP_SYNC is the name of the request message and WEBM_NODE is the node
representing the Integration Server.
5. If you are using PeopleTools version 8.48 or 8.49, select the event (for example, SavePostChange),
and type the following code in the PeopleCode Editor:
Local Message &request, &response;
Local Rowset &rep;
&rep = GetLevel0();
&request = CreateMessage(Operation.WEBM_SO);
&request.CopyRowsetDelta(&rep);
&response = %IntBroker.SyncRequest(&request, Node.WEBM_NODE);

where WEBM_SO is the name of the service operation and WEBM_NODE is the node
representing the Integration Server.
6. Click the Save.

Using the PeopleSoft Adapter's Sample and Utility Services
After you set up your PeopleSoft Web server to send messages to the Integration Server, you must
handle those messages (for example, accept the XML documents and then send reply messages
to PeopleSoft, if required) as they are received by the Integration Server.
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You can create your own services in the Integration Server to handle the messages, or you can use
the sample flow service wm.adapter.peoplesoft.outbound.sample:receiveXML, which is provided in the
WmPeopleSoftAdapter package, to handle the messages.
The wm.adapter.peoplesoft.outbound.sample:receiveXML flow service consists of the following services:
Service Name

Description

wm.adapter.peoplesoft.outbound.sample:getXML

Sample Java service that receives XML
messages (for example, a REP_SYNC message)
into a String.

wm.adapter.peoplesoft.outbound.sample:getDBTableName Sample Java services that extract fields from
received XML messages.
wm.adapter.peoplesoft.outbound.sample:mergeData
wm.adapter.peoplesoft.outbound.sample:createReplyXML Sample Java service that creates a response
message (for example, WEBM_REPLY), in the
XML format required by PeopleSoft.
Built-in services that convert a string to a
record.

pub.web:stringToDocument
pub.web:documentToRecord

A built-in service that sends a response
document back.

pub.flow:setResponse

The adapter also provides the following utility services in the WmPeopleSoftAdapter package:
Service Name

Description

wm.adapter.peoplesoft.outbound.utils:testSetResponse Tests the response XML.
wm.adapter.peoplesoft.outbound.utils:encoding

Encodes the username and password.

To use the sample services, you must modify the services for your specific outbound transactions.
The samples contain comments that illustrate where you need to update them. For more information
about outbound transactions, see “PeopleSoft-to-webMethods Communications” on page 27.

Using SSL to Communicate with the Integration Server
The following configuration needs to be done on your PeopleSoft system. For detailed instructions
on how to implement SSL encryption in PeopleSoft, see the PeopleBooks PeopleSoft Integration
Broker document.
Before you set up your PeopleSoft system to use SSL to communicate with the Integration Server,
you must first configure the Integration Server to enable an HTTPS port. If you need instructions
for setting up an HTTPS port, see the webMethods Integration Server Administrator’s Guide for your
release.
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To use SSL to communicate with the Integration Server running on an HTTPS port
1. Copy the CA Certificate used to set up an HTTPS port on the Integration Server to a temporary
folder.
2. Copy the pskey file from the application server to the temporary folder. You can find the pskey
in one of the following locations:
For WebSphere:
WebSphere_directory\Appserver\installedApps\peoplesoft\keystore
For WebLogic:
WebLogic_directory/config/peoplesoft/keystore
3. Make a backup copy of the pskey file.
4. Use the following command to add your CA Certificate to the key store:
JDK_1.3_Home_directory /bin/keytool -import -trustcacerts -alias
-file YOUR_CACERT.CER -keystore pskey -storepass password

YourCompany

where YourCompany is the name with which you will identify your CA Certificate, pskey is the
file name of the keystore, and password is the password protecting the keystore. Initially its
value is "password". If the default password value has changed, you can get it from the
integrationgateway.properties file.
5. Restart your WebLogic or WebSphere application server.
6. You can now send your messages to the HTTPS URL that points to your Integration Server.
For URL syntax and instructions, see “Configuring a Node” on page 81.

Monitoring PeopleSoft Request Messages
To monitor messages sent from PeopleSoft to webMethods
1. Launch your browser and go to the following URL (if you have not already done so):
http://App_Server_Hostname:Port_Number/ps/signon.html
where App_Server_Hostname refers to WebLogic or WebSphere, as appropriate, and Port_Number
refers to the port number of the application server.
Example: http://parts.west.smithco.com:8080/ps/signon.html
2. Click the PeopleTools link.
3. From the PeopleSoft menu, select Integration Broker and click Monitor Messages.
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The Overview tab shows the list of messages. When an outbound transaction completes, the
request message (for example, REP_SYNC) will be displayed on this tab with its corresponding
status.
4. See the PeopleBooks PeopleSoft Integration Broker document for more information about
administering messages.
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Predefined Health Indicator
Microservices Runtime includes predefined health indicators for some of its basic components.
The health indicator captures the connection details for all the WmART based adapters at runtime.
For more information, see webMethods Adapter Runtime User's Guide.

96

webMethods PeopleSoft Adapter Installation and User’s Guide 6.0

8 Administrator APIs
■

Administrator APIs ..........................................................................................................

webMethods PeopleSoft Adapter Installation and User’s Guide 6.0

98

97

8 Administrator APIs

Administrator APIs
The Administrator APIs are available for PeopleSoft Adapter. For more information about
Administrator APIs and samples, see webMethods Adapter Runtime User's Guide.
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Configuration Variables Templates for Adapter Assets in
Microservices Runtime
The webMethods Adapter Runtime (ART) asset properties that can be configured from Integration
Server Administrator are available in the configuration variables template (application.properties
file) generated by Microservices Runtime. For more information, see webMethods Adapter Runtime
User's Guide and Developing Microservices with webMethods Microservices Runtime.
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Overview
The following sections describe message logging and exception handling for the PeopleSoft
Adapter. A list of error codes and supporting information appears in “ PeopleSoft Adapter Error
Codes” on page 104.

PeopleSoft Adapter Logging Levels
The PeopleSoft Adapter uses the Integration Server logging mechanism to log messages. You can
configure and view the Integration Server logs to monitor and troubleshoot the PeopleSoft Adapter.
For detailed information about logging in the Integration Server, including instructions for
configuring and viewing the different kinds of logs supported by the server, see the webMethods
Integration Server Administrator’s Guide for your release.

Configuring Adapter Logging Levels
Beginning with Integration Server 7.1, you can configure different logging levels for the PeopleSoft
Adapter.

Accessing Logging Information
To access the adapter's logging information
1. From the Integration Server Administrator screen, select Settings > Logging.
The Logging Settings screen appears. The Loggers section has Adapters included in the
Facility section.
2. Expand the Adapters tree to see a list of all installed adapters with their code number and
adapter description, along with the logging level.

Changing Logging Settings
To change logging settings for the adapter
1. Click Edit Logging Settings. Select the required Level of Logging for the PeopleSoft Adapter.
2. After making your changes, click Save Changes.
3. For complete information about specifying the amount and type of information to include in
the log, see the webMethods Audit Logging Guide for your release.
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PeopleSoft Adapter Message Logging
The Integration Server maintains several types of logs; however, the PeopleSoft Adapter only logs
messages to the audit, error and server logs. Because the PeopleSoft Adapter works in conjunction
with the WmART package, the adapter's messages and exceptions typically appear within log
messages for the WmART package.
The logging levels are different depending on which version of the Integration Server you are
running the adapter on, as shown in the following table.
Integration Server

Log

Description

Integration Server 6.5

Audit Log

You can monitor individual adapter services using the
audit log as you would audit any service in the
Integration Server. The audit properties for an adapter
service are available in each PeopleSoft Adapter service
template on the Audit tab.

Error Log

The PeopleSoft Adapter automatically posts critical-level
and error-level log messages to the server's error log.
These log messages will appear as adapter run-time
messages.

Server Log

The PeopleSoft Adapter posts messages to the Server log,
depending on how the server log is configured.
Critical-level through debug-level log messages appear
as Adapter Run time log messages. V1-Verbose1 or
V4-Verbose4 log messages appear as PeopleSoft Adapter
log messages.

Audit Log

You can monitor individual adapter services using the
audit log as you would audit any service in the
Integration Server. The audit properties for an adapter
service are available in each PeopleSoft Adapter service
template on the Audit tab.

Error Log

The PeopleSoft Adapter automatically posts fatal-level
and error-level log messages to the server's error log.
These log messages will appear as adapter run-time
messages.

Server Log

The PeopleSoft Adapter posts messages to the server log,
depending on how the server log is configured. Fatal-level
through debug-level log messages appear as adapter
run-time log messages. Trace-level log messages appear
as PeopleSoft Adapter log messages.

Integration Server 7.1
and higher

The PeopleSoft Adapter's log messages appear in the following format: ADA.0336.nnnnc, where:
ADA is the facility code that indicates that the message is from an adapter.
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0336 (or 336) is the PeopleSoft Adapter major code, which indicates that the error is generated
by the PeopleSoft Adapter.
nnnn represents the error's minor code. For detailed descriptions of the PeopleSoft Adapter's
minor codes, see “ PeopleSoft Adapter Error Codes” on page 104.
c represents the message's severity level (optional).
Because the PeopleSoft Adapter works in conjunction with the WmART package, the adapter's
messages and exceptions typically appear within log messages for the WmART package, although
that is not necessarily true for verbose-level messages.
To monitor the PeopleSoft Adapter's log messages in the Server log, ensure that your server log's
logging settings are configured to monitor the following facilities:
0113 Adapter Runtime (Managed Object)
0114 Adapter Runtime
0115 Adapter Runtime (Listener)
0116 Adapter Runtime (Notification)
0117 Adapter Runtime (Adapter Service)
0118 Adapter Runtime (Connection)
0121 Adapter Runtime (SCC Transaction Manager)
0126 Adapter Runtime (SCC Connection Manager)

Handling PeopleSoft Exceptions
If a PeopleSoft Adapter object (for example, a connection or service) encounters an error with the
PeopleSoft system, it will throw an adapter error coupled with the PeopleSoft error, exactly as it
was thrown by PeopleSoft. The PeopleSoft errors will be in an IData format.
For example, if a Get service fails on the PeopleSoft system at run time because its input fields
contain invalid key values, you will receive an adapter error that indicates that the Get service
failed, and the adapter error will contain the specific error generated on the PeopleSoft system
indicating why the service failed. In this case, you would receive a PeopleSoft error specifying
that the input key field values are invalid.

PeopleSoft Adapter Error Codes
This section lists the PeopleSoft Adapter's Critical- and Error-level minor codes, including the text
of each error, information about the cause of the errors, and possible responses to the errors.
Error Code

Description

1000

PeopleSoft Session Connection failed
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Error Code

Description
Explanation:The adapter encountered a problem when trying to connect to the
PeopleSoft system.
Action:Check to see if the PeopleSoft application server is down, if there are
network problems, or if the WmPeopleSoftAdapter\code\jars directory contains
the correct psjoa.jar file.

1001

PeopleSoft operation error
Explanation:This is a generic error that occurs if something goes wrong with a
Get, Find, Update, Insert, or Delete Row service. The error will contain the specific
exceptions or error from the PeopleSoft system.
Action:Check the PeopleSoft exception and error for details about the error.

1011

GET operation execution failed
Explanation:The Get service was unable to complete the operation because it
encountered an error in the PeopleSoft system. The adapter error contains the
specific PeopleSoft error.
Action:See the PeopleSoft error for details.

1012

FIND operation execution failed
Explanation:The Find service was unable to complete the operation because it
encountered an error in the PeopleSoft system. The adapter error contains the
specific PeopleSoft error. This error will contain the specific PeopleSoft exception
and error.
Action:See the PeopleSoft error for details.

1013

INSERT operation execution failed
Explanation:The Insert service was unable to complete the operation because it
encountered an error in the PeopleSoft system. The adapter error contains the
specific PeopleSoft error. This error will contain the specific PeopleSoft exception
and error.
Action:See the PeopleSoft error for details.

1014

UPDATE operation execution failed
Explanation:The Update service was unable to complete the operation because
it encountered an error in the PeopleSoft system. The adapter error contains the
specific PeopleSoft error. This error will contain the specific PeopleSoft exception
and error.
Action:See the PeopleSoft error for details.

1015

Delete Row operation execution failed
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Error Code

Description
Explanation:The Delete Row service was unable to complete the operation because
it encountered an error in the PeopleSoft system. The adapter error contains the
specific PeopleSoft error. This error will contain the specific PeopleSoft exception
and error.
Action:See the PeopleSoft error for details.

1021

Problem connecting to PeopleSoft server - check logs
Explanation:The adapter encountered a problem trying to connect to the
PeopleSoft system.
Action:Check to see if the PeopleSoft application server is down, if there are
network problems, or if the WmPeopleSoftAdapter\code\jars directory contains
the correct psjoa.jar file.

1022

Problem getting the CI Info of CI - check logs
Explanation:The component interface cannot be found, contains invalid properties,
or is not included in the Permissions List for the user that is specified in the
service's associated adapter connection. This error will contain the specific
PeopleSoft exception and error.
Action:See the PeopleSoft error for details.

1050

PeopleSoft Application Server is not responding
Explanation:The adapter attempted to connect to the PeopleSoft system, but the
PeopleSoft system did not respond.
Action:Check to see if the PeopleSoft application server is down, if there are
network problems, or if the WmPeopleSoftAdapter\code\jars directory contains
the correct psjoa.jar file.
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Data Type Mapping
The adapter maps the PeopleSoft data types between component interface methods to adapter
services as follows:
PeopleSoft data type code

PeopleSoft API data type

Service Data Type

0 - Character

String

String

1 - Long Character

String

String

2 - Number

BigDecimal/Float/String

String

3 - Signed Number

BigDecimal/Float/String

String

4 - Date

String

String

5 - Time

String

String

6 - DateTime

String

String

7 - SubRecord (not supported with
component interfaces)

Object

N/A

8 - Image (limited support with component N/A
interfaces)

N/A

9 - ImageReference (not supported with
component interfaces)

N/A

N/A

10 - Collection Object

Object

Record List

Note:
Your PeopleSoft system validates and converts data types, not the adapter.
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